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HP Support 

Online Services:  for 24-hour 
access to information over your 
modem, we suggest these 

World Wide Web URL - Printer drivers, updated HP printer software, 
plus product and support information may be obtained from the 
following URLs:
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services: in the U.S. http://www.hp.com
in Europe http://www2.hp.com
Printer drivers may be obtained from the following sit
in Japan ftp://www.jpn.hp.com/drive
in Korea http://www.hp.co.kr
in Taiwan http://www.hp.com.tw
or the local driver website http://www.dds.com.tw

America Online - America Online/Bertelsmann is av
U.S., France, Germany, and U.K. - Printer drivers, upd
software, and support documentation to help answer
about HP products are available. Use Keyword HP to
or call 1-800-827-6364 preferred customer # 1118 to
Europe, call the appropriate number below:
Austria 0222 58 58 485
France ++353 1 704 90 00
Germany 0180 531 31 64
Switzerland 0848 80 10 11
United Kingdom 0800 279 1234

CompuServe - Printer drivers, updated HP printer so
interactive sharing of technical information with other
available on CompuServe’s “HP User’s forums” (GO 
1-800-524-3388 and ask for representative #51 to su
(CompuServe is also available in the U.K., France, B
Switzerland, Germany, and Austria.)

Obtaining software 
utilities, drivers, and 
electronic Information 
for U.S. and Canada:

Phone:
(805) 257-5565

Mail:
Hewlett-Packard Co.
P.O. Box 1754
Greeley, CO 80632
U.S.A.

Fax:
(805) 257-6866

For Asia-Pacific 
countries:

Contact Mentor Media at (65) 740-4477 (Hong Kong
Philippines, Malaysia, or Singapore). For Korea, call 
3270-0805 or (82) (2) 3270-0893.

For Australia, New 
Zealand, and India:

For Australia and New Zealand, call (61) (2) 565-609
For India, call (91) (11) 682-6035.

For European English: For U.K., call (44) (142) 986-5511. For Ireland and ou
call (44) (142) 986-5511.

HP direct ordering for 
accessories or supplies:

Call 1-800-538-8787 (U.S.) or 1-800-387-3154 (Cana

HP Support Assistant 
compact disc:

This support tool offers a comprehensive online infor
designed to provide technical and product informatio
products. To subscribe to this quarterly service in the 
call 1-800-457-1762. In Hong Kong, Indonesia, Mala
Singapore, call Mentor Media at (65) 740-4477.
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HP Service Information: To locate HP-Authorized Dealers, call 1-800-243-9816 (U.S.) or 
1-800-387-3867 (Canada).

HP Service Agreements: Call 1-800-835-4747 (U.S.) or 1-800-268-1221 (Canada).
Extended Service 1-800-446-0522
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HP Support  (continued)
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HP FIRST: HP FIRST Fax will deliver detailed troubleshooting information on common
troubleshooting tips for your HP product. Call from any touch tone phone and request up 
documents per call. These documents will be sent to the fax of your choice.

Australia +61 (0) 3 9272 2627 Korea +82 (0) 0

Austria 0660-8218 Malaysia +60 (0) 3

Belgium (Dutch) 0800 1 1906 Netherlands 0800-022

Belgium (French) 0800 1 7043 New Zealand +64 (0) 0

Canada 1-800-333-1917 Norway 800-1131

China +86 (0) 10 6505 5280 Portugal 05 05 31

Denmark 800-10453 Philippines +65 275 

English (outside of U.K.) +31 20 681 5792 Singapore +65 275 

Finland 800-13134 Spain 900-9931

France 0800-905900 Sweden 020-79-5

Germany 0130-810061 Switzerland (German) 0800-551

Hong Kong 852-2506-2422 Switzerland (French) 0800-551

Hungary (36) (1) 252-4647 Taiwan (886) (2)

India +91 (0) 11 682 6031 Thailand +66 (0) 2

Indonesia +62 (0) 21 352 2044 United Kingdom 0800-960

Italy 1678-59020 United States 1-800-33

Japan +81 (0) 3 3335 8622
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Customer Support Worldwide

Customer Support and Product 
Repair Assistance for the U.S. and 

Call (1) (208) 323-2551 Monday through Friday from 6 
am to 10 pm, Saturday 9 am to 4 pm (Mountain Time) 
free of charge during the warranty period. However, your 
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er ready when 

l 
P-Authorized 
 HP centralized 

ailable to 
900) 555-1500 
0-999-1148 
nd Canada) 
 and Saturday 

rges begin only 
ian. *Prices 

phone number 
 support after 
umber. The fee 
 product name 

180) 525-8143
0660-6386

11-6299
929-4099
) 0203-47288
) 619-2170
4-10350
232-1123
1) 441-7199
EN

Canada:

(Refer to the service and support 
chapter of this user guide for 
additional product repair 
information.)

standard long-distance phone charges st
your system nearby and your serial numb
calling. 

If you know your printer needs repair, cal
1-800-243-9816 to locate your nearest H
service provider, or call 208-223-2551 for
service dispatch.

Post-warranty telephone assistance is av
answer your product questions. Call (1) (
($2.50* per minute, U.S. only) or call 1-80
($25* per call, Visa or MasterCard, U.S. a
Monday through Friday from 7 am to 6 pm
from 9 am to 3 pm (Mountain Time). Cha
when you connect with a support technic
subject to change.

European Customer Support Center Language and In-Country Options 
Available
Open Monday through Friday 8:30–18:00 CET

HP provides a free telephone support service during the warranty period. By calling a tele
listed below, you will be connected to a responsive team waiting to help you. If you require
your warranty has expired, you can receive support for a fee through the same telephone n
is charged on a per-incident basis. When calling HP, have the following information ready:
and serial number, date of purchase, and description of the problem.

English

Dutch

French

Ireland: (353) (1) 662-5525
U.K.: (44) (171) 512-5202
International: (44) (171) 
512-5202
Belgium: (32) (2) 626-8806
Netherlands: (31) (20) 
606-8751
France: (33) (01) 43-62-3434
Belgium: (32) (2) 626-8807
Switzerland: (41) (84) 880-1111

German

Norwegian
Danish
Finnish
Swedish
Italian
Spanish
Portuguese

Germany: (49) (
Austria: (43) (1) 

Norway: (47) 22
Denmark: (45) 3
Finland: (358) (9
Sweden: (46) (8
Italy: (39) (2) 26
Spain: (34) (90) 
Portugal: (351) (
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In-country support numbers:   If you require support after your warranty has expired, additional 
product repair services, or if your country is not listed below, see “Worldwide Sales and Service Offices.”

Argentina 787-8080 Japan (81) (3) 3335-8333

Australia (61) (3) 272-8000 Malaysia (60) (3) 295-2566
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11
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Customer Support Worldwide (continued)
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Brazil 022-829-6612 Mexico (Mexico City) 01 800-22147

Canada (1) (208) 323-2551 Mexico (outside 
Mexico City)

01 800-90529

China (86) (10) 65053888-5959 New Zealand (64) (9) 356-664

Chile 800-360999 Philippines (63) (2) 894-145

Czech 
Republic

(42) (2) 471-7321 Poland (48) (22) 37-506

Greece (30) (1) 689-6411 Portugal (351) (1) 301-73

Hong Kong (852) 800-96-7729 Russia (7) (95) 923-500

Hungary (36) (1) 343-0310 Singapore (65) 272-5300

India (91) (11) 682-6035 Taiwan (886) (02) 717-0

(91) (11) 682-6069 Thailand +66 (0) 2 661-40

Indonesia (62) (21) 350-3408 Turkey (90) (1) 224-592

Korea (82) (2) 3270-0700 

Korea outside 
Seoul, call 

(82) (080) 999-0700
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Getting to Know the Printer

This chapter provides information in the following areas:

l Printer Features

l Printer Software

l Control Panel

l Printing with the Infrared Port (Wireless Printing)

l Interface Ports

l Accessories and Ordering Information
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Printer Features 
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Fast Print 
Speed

l 10 pages-per-minute printing (with Intel 80960JD RIS
formatter).

Excellent Print 
Quality

l True 1200 x 1200 dots per inch (dpi) text and graphic
l Resolution Enhancement technology (REt) adjusts th

placement of each dot on the page to produce smoo
curves, and edges (600 dpi only).

l Adjustable settings to optimize print quality. 

l The HP UltraPrecise toner cartridge has a finer tone
which provides sharper text and graphics

Flexible Paper 
Handling

l Adjustable Tray 1 for letterhead, envelopes, labels, tr
custom-sized media, postcards, and heavy paper. Se
Media into Tray 1” on page 31.

l Adjustable Tray 2 or an optional 250-Sheet Input Tray
standard sizes of paper. See “Reloading Media into T
Optional Tray 3” on page 32.

l Two output bins: select either the top output bin or th
bin for the most convenient output location.

l Straight-through paper path capability from Tray 1 to 
bin. 

Expandability l Optional Tray 3 with a 250-sheet capacity to increase
before it is necessary to add paper.

l Enhanced Input Output (EIO) cards. See “Interface P
22.

l Dual In-line memory module (DIMM) slots for adding

l PostScriptTM Level 2 Emulation (PS) DIMM adds PS
Factory installed on the 2100 M and 2100 TN.

PCL Printer 
Language and Fonts

l Fast printing performance, built-in Intellifont and True
technologies, built-in HP-GL/2 vector graphics, and a
imaging capabilities are benefits of the PCL 6 printer
This also includes 45 scalable TrueType fonts and on
Line Printer Font.

PS Language and 
Fonts

l The HP LaserJet 2100 M and 2100 TN printers inclu
Level 2 printer language emulation with 35 built-in PS
fonts.
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Automatic Language 
Switching

l When optional printer languages (such as PS emulation) are 
installed, the printer automatically determines and switches to the 
appropriate language for the print job.
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Wireless Infrared 
Printing

l Fast infrared (IR) printing when printing from an IrDA
device, such as a laptop, notebook computer, or a Pe
Assistant (PDA).

l JetSend IR enabled devices can also use the IR por

Interface Connections l Bidirectional ECP type-B parallel port (IEEE-1284 co

l LocalTalk port

l EIO Slot
l Wireless Infrared port (IrDA compliant)

Networking l The printer provides an EIO Slot for HP JetDirect 60
servers for fast and easy connectivity.

l Use in Workgroups to provide flexibility, fast printing 
network, and remote management.

Enhanced Memory 
and Memory 
Expansion 

l The HP LaserJet 2100 printer comes with 4 MB of me
be expanded to 52 MB with the three available memo
slots. Most documents can be printed using the stand
printer memory through the aid of Memory Enhance
technology (MEt). MEt automatically compresses da
doubling the printer’s memory and allowing more com
with available memory.

l The HP LaserJet 2100 M and 2100 TN printers com
memory and can be expanded to 40 MB with the two
memory (DIMM) slots. The third slot is used for the H
language DIMM.

Energy Savings l The printer automatically conserves electricity by sub
reducing power consumption when not printing.

l As an ENERGY STAR partner, Hewlett-Packard Comp
determined that this product meets ENERGY STAR gu
energy efficiency.

Economical Printing l EconoMode (600 dpi only), manual duplexing, and N
you save paper, toner, and time.

l For tips on reducing the amount of paper use or exten
the toner cartridge, see “Printing Tasks” starting on p
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Printer Software

The printer comes with helpful software including printer drivers and 
optional software. The printer drivers (Windows) and PPDs 
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(Macintosh and Windows) provided must be installed to
advantage of the printer’s features.

This section provides information in the following areas:

l Printer Software Installation Instructions

l Overview of Printing System Components

l Printer Software Installation Tips

Once you have followed the installation instructions and
software, refer to the printer software tasks on page 44 o
the most out of your printer.

Note HP software is not available in all languages.

Check the ReadMe file provided on the compact disc or f
additional software included and supported languages. 
recent drivers, additional drivers, and other software are a
the Internet and other sources. If you do not have access t
see the HP Support pages at the front of this user guide
most recent software.

The HP LaserJet 2100 Series printer comes with drivers
following platforms and operating environments. Find yo
system and follow the instructions to start the installation

l “Windows Installation” on page 5

l “Macintosh Installation” on page 10 (HP LaserJet 21

l “DOS Installation” on page 12
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Windows Installation
1. Run the install program by following the instructions for your 

Windows version.

uctions.

options 

ds printer 
er, and a 
ll printing 

is option 
fonts.

inistrators): 
nts will be 
 to select the 

ll at least one 

D-ROM drive. 
y.

tions.
ot automatically 

enu, and type 
 (where x is the 

 drive). Then 
tion instructions.

e CD-ROM 

Run.

 the drive letter 

tions. 
EN Chapter 1 Pri

Note If you don’t have a CD-ROM drive, see page 13 for instr

2. Select installation type. The installer provides three 
for software installation.

• Typical  (recommended method): This option loa
drivers, screen fonts, HP FontSmart, an uninstall
configuration utility that will allow you to control a
aspects.

• Minimal  (for laptops and minimal installation): Th
loads only the required printer driver and screen 

• Custom  (for experienced users and network adm
This option allows you to choose which compone
installed. The installation program will prompt you
software items you wish to install. You must insta
printer driver to use your printer. 

Windows Version To start installation:

Windows 9x/NT 4.0 a. Place compact disc in the C
Install will start automaticall

b. Follow the on-screen instruc
If the CD-ROM drive does n
run:
Select Run from the Start m
x:\setup in the Open box
drive letter for the CD-ROM
follow the remaining installa

Windows 3.x a. Place the compact disc in th
drive. 

b. From the File menu, select 

c. Type x:\setup  (where x is
of your CD-ROM drive).

d. Follow the on-screen instruc
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3. Register your printer with HP.

If you have access to the World Wide Web, please take a moment to 
complete the registration for your HP LaserJet 2100 at the following 
website:
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http://www.hp.com/go/lj2100_register

This will help Hewlett-Packard better provide support for
After registering, you will have the option to receive valua
tools. Hewlett-Packard will not contact you or send you i
unless you explicitly approve it during the registration pr
may also register with the reply card included with your 

Software for Windows

Printer Drivers

Printer drivers access the printer’s features and allow the
communicate with the printer. Choose a printer driver ba
way you use the printer.

l Use the PCL 6 driver to take full advantage of the p
features. Unless complete backward compatibility w
PCL drivers or older printers is necessary, the PCL
recommended.

l Use the PCL 5e driver if you need print results to loo
with those from older HP LaserJet printers. Certain 
not available in this driver. (Do not use the PCL 5e dr
with this printer with older printers.)

l Use the PS driver for compatibility with PS needs. C
features are not available in this driver.

If your printer has PS capabilities, the printer automatica
between PS emulation and PCL printer languages depe
driver you have selected.

Each printer driver has help screens that can be activate
Help button, the F1 key, or a question mark symbol in th
corner of the printer driver (depending on the Windows 
system used). These help screens give detailed informat
specific driver. Printer driver help is separate from the so
application help.
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Note For driver only or OEM setup, see the Readme on the installation CD.
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Access HP FontSmart from the HP LaserJet folder or th
Start menu. HP FontSmart is a font management utility 
only) which does the following:

l Installs, uninstalls, and deletes fonts.

l Manages fonts inside a single window by allowing y
and-drop.

l Shows the matching screen fonts for the internal fon
printer.

HP LaserJet Configuration Utility 
(Windows 9x/NT 4.0 only)

The HP LaserJet configuration utility manages printer de
It allows you to access many of the printer’s features, in

l Printing PCL and PS test, font, and demo pages.

l Selecting page setup defaults.

l Choosing custom settings, such as reprint or tray lo

l Setting resource options, such as IO buffering.

HP JetAdmin (CD-ROM only)

HP JetAdmin is designed to be used primarily by netwo
administrators who are responsible for installing, configu
troubleshooting, and maintaining printers and other dev
network. Users may also use the status messages repo
HP JetAdmin to perform common troubleshooting (pape
out, etc.) and to confirm the current status of the printer
network. HP JetAdmin can be accessed by clicking the 
pointing to Settings, and then clicking Control Panel in W
and Windows NT 4.0, or from the HP JetAdmin Utilities 
group folder in Windows 3.x. Use HP JetAdmin to do the

l Install, configure, and manage printers on a network
connected with a HP JetDirect 600 N print server.

l Perform in-depth diagnostics on the printer and netw

The HP JetAdmin software works on the following netwo

l Windows NT l Windows 9x
l SunOS* l Novell NetWare
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*The software for these systems is not included on the c
with the printer, but is available from the Internet. If you 
access to the Internet, see the HP Support pages at the
user guide to obtain this software.

Note Network Administrators: If the printer is attached to a ne
you can print, the printer must be configured for that net
HP JetAdmin or similar network software. 
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HP JetSend (CD-ROM - Windows 9x/NT 4.0 only)

HP JetSend is a new technology from Hewlett-Packard that allows 
devices to communicate with each other simply and directly. HP 
JetSend is built into your printer, allowing it to receive information 
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from any JetSend-enabled sending device anywhere on
network, whether in the same office, or at a remote loca
printer also has infrared capabilities, allowing it to receiv
from any JetSend- enabled infrared device. Examples o
sending devices include PC's or laptops running JetSend
scanners with JetSend built in. JetSend uses simple IP 
between networked devices, and "Point and shoot" betw
devices.

Visit the JetSend web site (www.jetsend.hp.com) for add
information on JetSend and JetSend software for the PC
allows you to exchange intra-company documents direc
PCs and between PCs and any JetSend-enabled printe
problems of incompatible software applications or versio
software will allow your colleagues to create documents
and send copies directly to this printer without any devic
drivers or configuration difficulties.

You can visit the JetSend web site to learn which other d
available to communicate easily and directly with your J
enabled printer.

How the JetSend Communications Technology

Networked Devices

To use the JetSend capability between networked devic
configuration page to find your JetSend IP address and 
address to anyone who wishes to send information to yo
JetSend.

From a JetSend sending device, a person only needs to
address of the printer and press "send."

Infrared Devices

To use the JetSend infrared capability, simply (1) line up
sensors between the sending and receiving devices, an
the "send" option on the sending device.

The devices, because they have JetSend in them, will a
negotiate the best possible outcome.

HP JetSend Software is not currently available for the M
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Macintosh Installation
1. Run the install program by placing the compact disc in the 

CD-ROM drive. The installation window will appear on the 
desktop. Select the correct language and double-click the 
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installer icon.

Note Virus protection must be turned off prior to starting the i
program.

The compact disc contains software for many internatio
Once you select the installation language and double-clic
desired language, the installation screen will appear in t

2. Select installation type. The installer provides two o
for software installation.

• Typical  (recommended method): This option loa
screen fonts, and a utility that controls all printing

• Custom  (for experienced users and network adm
This option allows you to choose which compone
installed. The installation program will prompt you
software items you wish to install.

3. Register your printer with HP.

If you have access to the World Wide Web, please take 
complete the registration for your HP LaserJet 2100 at t
website:

http://www.hp.com/go/lj2100_register

This will help Hewlett-Packard better provide support for
After registering, you will have the option to receive valua
tools. Hewlett-Packard will not contact you or send you i
unless you explicitly approve it during the registration pr
may also register with the reply card included with your 

Note The Apple LaserWriter 8 driver must be installed to use 
make best use of the features of the printer, use the ver
LaserWriter driver included on the CD.
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Software For Macintosh Computers

PostScript Printer Description Files (PPDs)

PPDs, in combination with the LaserWriter driver, access the printer 
e printer. An 
d other 
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features and allow the computer to communicate with th
installation program for the PPDs, LaserWriter driver, an
software is provided on the compact disc. 

HP LaserJet Utility

HP LaserJet Utility allows control over features that are 
in the driver. The illustrated screens make selecting prin
from the Macintosh computer easier than ever. Use the 
Utility to do the following:

l Name the printer, assign it to a zone on the network
files and fonts, and change most of the printer settin

l Set a password for the printer.

l From the computer, lock out functions on the printer
unauthorized access. 
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DOS Installation

DOS Remote Control Panel

1. Place the compact disc in the CD-ROM drive.

e letter of 
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2. From the DOS prompt, type x : (where x is the driv
the CD-ROM drive), and press Enter. 

3. Change to the appropriate language directory 
(for example: cd\english ).

4. Type install  and press Enter.

If DOS applications are going to be used with the printer
Remote Control Panel was not installed, the AUTOEXEC
needs to be modified to prevent communication timeout
modify the AUTOEXEC.BAT file, use any DOS editor, or
processing program that edits ASCII text files, and follow
instructions below.

For DOS versions 4.0 and later, add:

MODE LPT1:,,B

For DOS versions earlier than 4.0, add:

MODE LPT1:,,P

Note The preceding examples assume you are using printer p
you are using LPT2 or LPT3, replace LPT1 in the preced
with the appropriate printer port number.

Using the Remote Control Panel
The Remote Control Panel (RCP) enables you to chang
settings if the DOS software application does not suppo
feature you want to use. To start the RCP from DOS, fol
steps:

1. Make sure that the RCP is in the computer’s path sta
can be checked by typing PATH at a DOS prompt at
directory and pressing Enter. If the Remote Control 
directory is not in the path statement, change to the
directory C:\HPLJUTIL.

2. At the DOS prompt, type RCP and press Enter.

3. For additional information, select Help.
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Software Installation Tips 

I do not have a CD-ROM drive.

If you have access to another computer with a CD-ROM drive, you 
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can use the MakeDisk utility in Windows to create the di
for the installation. Follow the first step of the installation
and choose MakeDisk to create the disks. 

If you have internet access, you can download drivers fr
Wide Web or HP’s FTP servers. The driver web page is

http://www.software.hp.com

For non-U.S. customers only: Use the floppy disk(s) sup
printer to install the software. 

If you do not have disks, see “HP Support” in the front of
ordering information.

How do I access printer features?

Some printer features, such as custom paper sizes and 
orientation, may be available through your application se
application settings, if available, because they override p
settings.

Access advanced printer features through your printer d
“Software Tasks” on page 44 for instructions on using sp
driver features. 

What additional drivers and software upgrades
available to me?

The latest printer drivers and printing software for HP La
printers are available on the World Wide Web 
(http://www.software.hp.com). Check the “Readme” file 
release information.
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What other software is available to me?

See “Printer Software” on page 4 for descriptions of the optional 
printing system software available for installation.
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Note Check the ReadMe file provided on the compact disc fo
software included and supported languages. The most r
additional drivers, and other software are available from
and other sources. If you do not have access to the Inte
HP Support pages at the front of this user guide to obta
recent software.

How do I remove the printing software?

In Windows, after installation, the Uninstall icon in the H
program group allows you to select and remove any or a
Windows HP printing system components.

Starting the Uninstaller:

1. In the HP LaserJet Program Group, double-click the
icon.

2. Click Next.

3. Select the HP printing system components you wan

4. Click OK.

5. Follow the prompts.
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Button Usage
The printer has two buttons: JOB CANCEL and GO.

Job Cancel

Press JOB CANCEL to cancel a job the printer is currently
control panel lights will cycle while the print job is cleare
the printer and the computer, and then return to ready. T
some time, depending on the size of the print job.

l If JOB CANCEL is accidentally pushed, the job must b
There is no undo function. 

l If JOB CANCEL is pushed when the printer is idle, the
status lights will cycle, but nothing else will happen.

Go 
l Press GO to resume printing when the printer is pau

unprinted data is still in the printer.

l Press GO to clear some printer errors.

l Press GO to print a demo page. The printer must be
state.

!

Job Cancel 
Button

Attention Light

Ready Light

Go Light and 
Button
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Light Patterns
Light patterns provide both status and error messages. The lights can 
be in any one of the following states:

onditions of 
ention light is 
oting Error 

ther.
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Control Panel Light Messages
The following control panel messages indicate various c
the printer in preparation for, or during, printing. If the Att
on, the printer is experiencing an error. See “Troublesho
Messages” on page 99. 

Startup
The Go, Ready, and Attention lights cycle one after ano

The buttons have no effect until the printer is ready.

Ready
The Ready light is on and the printer is ready to print.

No action is needed.

Pressing the GO Button will print a demo page.

OnOff Blinking
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The printer is receiving or processing data.

Pressing JOB CANCEL cancels the current job. One or tw
print as the printer clears the print job. The printer will re
ready state after the job has been canceled.

Data 
The Ready light is blinking and the Go light is on. 

Data is in the printer memory waiting to be printed. Pres
button prints from Tray 1 or from another tray if Tray 1 is
the paper size is supported in the other Tray.

Pressing the JOB CANCEL button cancels the current job
printer returns to ready.

Manual Feed with Pause
The Go light is blinking. Pressing the Go button prints fr
from another tray if Tray 1 is empty.

Pressing the JOB CANCEL button cancels the current job
printer returns to ready.
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Paper Out 
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The attention light is on. 

The printer is out of paper. The attention light will stay on
added.

Pressing the GO or JOB CANCEL button has no effect.

Paper Out (requested tray) 
The GO light is on. 

The requested tray is out of paper. Adding paper to the re
causes the printer to start the print job from that tray. 

Pressing the GO button prints from another tray.

Pressing the JOB CANCEL button cancels the current job

Attention
The printer requires attention for one of the following cir

l door open

l toner cartridge missing

l paper jam

Pressing the GO button causes the printer to attempt to 
paper jam.
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Pressing the GO button causes the printer to attempt to 
the error and print whatever it can. If the recovery is unsu
printer will return to the continuable error state. See “Co
Error” on page 100.

Service Error
The printer has experienced an error and cannot recove
lights are on. See “Service Error” on page 101.

Accessory Error
The printer has experienced an error and cannot recove
lights are blinking in unison. See “Accessory Error” on p
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Printing with the Infrared Port (Wireless Printing) 

The infrared (IR) port is located on the lower right corner of the 
printer. This port is compliant with the specifications determined by 
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the Infrared Data Association (IrDA). On the right side of
a status light that indicates when the port is active. The 
transmits data at speeds of up to 4 MB per second. Whe
connection is established, the IR status light comes on. 
connection is broken, or when the print job is complete, 
light goes off.

To use the IR port, you need the following:

l A computer or Personal Digital Assistant (PDA) equ
IrDA-compliant IR port.

l An infrared port driver that allows printing from the c
the printer using the IR port and the IrDA communic
protocol. 

l A printer driver to generate data that the printer can

Note Check with your hardware or operating system manufac
correct port driver.

IR Status Light

IR Port
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Printing Instructions 
1. Make sure the printer is in ready state (Ready light on). 

2. Align an IrDA-compliant computer within 1 meter (3 feet) of the IR 
port. Ensure that the ports are facing each other with no more 

 and below. 
 light will turn 
EN Chapter 1 Prin

than a 15° angle to either the left and right or above
Send the print job from the computer. The IR status
on when the connection has been made.

1 Meter
(3 Feet)

15°
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Interface Ports

The HP LaserJet 2100 and the 2100 M printers include two interface 
ports: an IEEE-1284 parallel and a LocalTalk port.

etDirect 
) port.

 port
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The HP LaserJet 2100 TN printer also includes an HP J
600 N print server card that includes a 10Base-T (RJ-45

LocalTalk

RJ-45 port

Parallel port
(IEEE-1284) 
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Accessories and Ordering Information

The following list of accessories was current at the time of printing. 
Ordering information and availability of the accessories may change 
EN Chapter 1 Prin

during the life of the printers.

Accessories

Option Description or Use Part Number

Toner Cartridge

Toner cartridge UltraPrecise toner cartridge 
Pallet Quantity

C4096A
C4097A

Memory and Language

Memory upgrades The HP LaserJet 2100 printer comes 
with 4 MB of memory and can be 
expanded to 52 MB with the 3 available 
memory (DIMM) slots.
The HP LaserJet 2100 M and 2100 TN 
printers come with 8 MB of memory and 
can be expanded to 40 M1B with the 2 
available memory (DIMM) slots. 

4 MB C4135A 
8 MB C4136A 
16 MB C4137A

HP PS DIMM The PS DIMM includes 4 MB of 
memory. This comes installed in the 
HP LaserJet 2100 M and 2100 TN 
printers.

C3098A 
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2950A
2951A

Accessories (continued)

Option Description or Use Part Number
24  Chapter 1 Printer Basics

Cable and Interface Accessories

HP JetDirect 600 N EIO Print 
servers

Ethernet (10Base-T)
Ethernet (10Base-T,10Base2 LocalTalk)
TokenRing (RJ-45 and DB9)
Fast Ethernet (10/100Base-TX, RJ-45)

J3110A
J3111A
J3112A
J3113A

Parallel Cables (IEEE-1284) A=host computer connector (A-type) 
B=large printer connector (B-type)

2 Meter A to B C
3 Meter A to B C

LocalTalk Network Kit for 
Macintosh

Connect to a LocalTalk Network 92215N

Serial printer cable for 
Macintosh

Connect to a Macintosh computer 92215S

Paper Handling Accessories

250-Sheet Input Tray (Tray 3) 
and 
Feeder Unit

Tray (for Letter, Executive, Legal, A4, 
A5, B5 (ISO), B5 (JIS), and 8.5 by 13 
inch paper sizes)
The optional Tray 3 comes with the 
2100 TN printer.

C4793A

Tray 2 or optional Tray 3 
replacement

Tray (for Letter, Executive, Legal, A4, 
A5, B5 (ISO), B5 (JIS), and 8.5 by 13 
inch paper sizes)

RG5-4137

Media Accessories

HP Multi-purpose Paper HP brand paper for a variety of uses 
(1 box of 10 reams, 500 sheets each). 
To order a sample, in the U.S. call 
1-800-471-4701.

HPM1120

HP LaserJet Paper Premium HP brand paper for use with 
HP LaserJet printers (1 box of 10 
reams, 500 sheets each). To order a 
sample, in the U.S. call 
1-800-471-4701.

 HPJ1124
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ed HP dealer for 
availability.

ces” on page 

Accessories (continued)

Option Description or Use Part Number
EN Chapter 1 Prin

HP LaserJet Labels Letter (8.5 by 11 in.) white labels
Letter (8.5 by 11 in.) clear labels
A4 (210 by 297 mm) white labels
A4 (210 by 297 mm) clear labels

Call an authoriz
label sizes and 

Transparency Film Letter (8.5 by 11 in.) transparency film
A4 (210 by 297 mm) transparency film

92296T
92296U

Supplementary Documentation

HP LaserJet Printer Family 
Paper Specification Guide

A guide to using paper and other print 
media with HP LaserJet printers

5040-9092

HP LaserJet 2100, 2100 M, 
and 2100 TN Printers User 
Guide 

An additional copy of this user guide C4170-90901

To order HP LaserJet accessories and options see the “Worldwide Sales and Service Offi
124 for authorized HP dealers.
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2 Printing Tasks

mmon 
EN Chapter 2 Print

Overview

This chapter explains your printing options and gives co
printing tasks:

l Preparing for Printing

l Media Input Options

l Loading Media into Tray 1

l Reloading Media into Tray 2 or Optional Tray 3

l Changing Paper Size in Tray 2 or Optional Tray 3

l Printing Tasks

l Canceling a Print Job

l Software Tasks
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Preparing for Printing

Purchasing Paper and Other Media
uments. You 
uding up to 
verhead 
h as weight, 

ng printer 

quality, 
edia 

antities. 
 specified in 
e. See 
28  Chapter 2 Printing Tasks

HP LaserJet printers produce excellent print quality doc
can print on a variety of print media, such as paper (incl
100% recycled fiber content paper), envelopes, labels, o
transparencies, and custom-sized media. Properties suc
grain, and moisture content are important factors affecti
performance and output quality.

To achieve the best possible print quality, use only high-
copier-grade paper. See Appendix B for more detailed m
specifications.

Note Always test a sample of paper before purchasing large qu
Your paper supplier should understand the requirements
the HP LaserJet Printer Family Paper Specification Guid
“Supplementary Documentation” on page 25.
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Media Input Options

The printer comes with two paper trays. By default, the printer draws 
first from Tray 1. If Tray 1 is empty, the printer draws from Tray 2 (or 

o a legal-size 
sed when 
EN Chapter 2 Print

optional Tray 3 if it is installed).

Tray 1 Media Sizes
Tray 1 adjusts for sizes from 76 by 127 mm (3 by 5 in.) t
sheet, 216 by 356 mm (8.5 by 14 in.). Tray 1 should be u
printing:

l Envelopes (see page 35)

l Labels (see page 37)

l Transparencies (see page 38)

l Custom-sized media or cardstock (see page 39)

l Postcards (see page 39)

Tray 2

Tray 1

Optional Tray 3
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Tray 2 and Optional Tray 3 Paper Sizes
Tray 2 and optional Tray 3 have settings for the following paper sizes:

l A4

n page 33 to 
 on page 140 

s of printable 
30  Chapter 2 Printing Tasks

l A5

l B5 (ISO and JIS)

l Letter

l Legal 

l Executive

l 8.5 by 13 in.

See “Changing Paper Size in Tray 2 or Optional Tray 3” o
change the paper size. See “Supported Sizes of Paper”
for specific dimensions.

CAUTION Use only paper from Tray 2 or optional Tray 3. Other type
media may jam if printed from Tray 2 or optional Tray 3. 
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Loading Media into Tray 1

Tray 1 (multi-purpose) holds up to 100 
 envelopes.

 the front 

y extender. If 
d is longer 
lso flip open 

uides slightly 

ay (short-
. The media 
tween the 
d under the 
h guides. 

uides inward 
the media 
hout bending 
a fits under 
width guides. 

 while the 
d cause a 

 “Letterhead 
ation” on 

1
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sheets of paper or up to 10

1 Open Tray 1 by pulling
cover down. 

2 Slide out the plastic tra
the media being loade
than 229 mm (9 in.), a
the tray extender. 

3 Slide the paper width g
wider than the media. 

4 Place media into the tr
edge in, print-side up)
should be centered be
paper width guides an
tabs on the paper widt

5 Slide the paper width g
until they lightly touch 
stack on both sides wit
it. Make sure the medi
the tabs on the paper 

Note
Do not add media to Tray 1
printer is printing. This coul
paper jam. 

For preprinted material, see
or Preprinted Forms Orient
page 42.

2

3

4

5
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Reloading Media into Tray 2 or Optional Tray 3

1 Pull the desired tray out of the 

tal paper lift 
. 

ke sure it is 
r corners. 
 the height 
th guide in 

 the printer. 

y from the 
he metal 
ut it back. 
leases and 

 push the tray 

1
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printer. 

2 Push down on the me
plate to lock it in place

3 Add the media and ma
flat in the tray at all fou
Keep the media below
tabs on the paper leng
the rear of the tray. 

4 Slide the tray back into

Note
Whenever you remove a tra
printer, always push down t
paper lift plate before you p
The metal paper lift plate re
lifts the paper up when you
into the printer.

2

3

4
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Changing Paper Size in Tray 2 or Optional Tray 3

1 Pull the desired tray out of the 
y paper. 

on the rear 
adjust for the 

 guide so the 
sired paper 

ides outward 

tal lift plate to 

1

EN Chapter 2 Print

printer and remove an

2 Press on the blue tab 
paper length guide to 
paper length.

3 Adjust the paper length
pointer matches the de
size.

4 Move the side width gu
as far as possible.

5 Push down on the me
lock it in place.

Continued on next page.

2

3

5

4
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6 Load up to 250 sheets into the 
the paper is 
r corners. 
 the height 
th guide in 

uides inward 
ia on each 
guides will 
izes 

 the printer.

6
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paper tray. Make sure 
flat in the tray at all fou
Keep the media below
tabs on the paper leng
the rear of the tray. 

7 Move the paper width g
so they touch the med
side. The paper width 
click into place for all s
supported by the tray.

8 Slide the tray back into

8

7
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Printing Tasks

Printing on Envelopes

in Tray 1, 
aged and are 
se envelopes 
s, coated 
, or other 
pendix B for 

 the front 

in by pulling 
n of the bin. 

 until it 

duces 

 on Tray 1 
than the 

1
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CAUTION
Before you load envelopes 
make sure they are undam
not stuck together. Never u
with clasps, snaps, window
linings, self-stick adhesives
synthetic materials. See Ap
media specifications.

1 Open Tray 1 by pulling
cover down. 

2 Open the rear output b
down on the top sectio
Slide out the extender
extends fully. 

Note
Using the rear output bin re
envelope curl.

3 Slide the width guides
outward slightly wider 
media. 

Continued on next page.

2

3
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4 Place the envelopes into the tray 
e up. The 

 the printer 

 inward until 
nvelope stack 
 envelopes 
tween the 
r the tabs on 
. 

n the short 
 the printer 

paper jams 
 a length less 
e caused by 
d by 
or optimum 
u are storing 
rectly. Please 
 Storage 
 Using media 
may also 

4
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short-edge in, print-sid
stamp end must enter
first. 

5 Slide the width guides
they lightly touch the e
without bending it. The
should be centered be
paper guides and unde
the paper width guides

Note
If the envelope has a flap o
edge, this edge must enter
first.

You may experience some 
when using any media with
178 mm (7 in.). This may b
paper that has been effecte
environmental conditions. F
performance, make sure yo
and handling the paper cor
refer to “Printing and Paper
Environment” on page 144.
from another manufacturer 
help.

5
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Printing on Labels
Only use labels recommended for laser printers, such as HP LaserJet 
labels. See “Labels” on page 148 for specifications.

l Print labels from Tray 1. 

 printed to 

ing sheet or 

sed or 

re than once. 
ugh the 

ve the toner 
5 to remove 

ation
p, top in)
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l Load labels print-side up.

l Use the rear output tray for labels.

l Remove label sheet from the output bin as they are
prevent them from sticking together. 

l Do not use labels that are separating from the back
are wrinkled or damaged in any way.

l Do not use label sheets with the backing sheet expo
partially used label sheets.

l Do not feed a sheet of labels through the printer mo
The adhesive backing is designed for one pass thro
printer. 

CAUTION If a sheet of labels becomes jammed in the printer, remo
cartridge and then see “Clearing Paper Jams” on page 8
the jammed labels.

Label Orient
(Print-side u
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Printing on Transparencies
Only use transparencies recommended for use in laser printers, such 
as HP transparency film. Ordering information is located on page 25. 
Appendix B lists transparency specifications on page 149.

t tray to 

move any 
.

g them from 
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l Print transparencies from Tray 1.

l Use the top output tray to reduce curling (this is for 
transparencies only; for other media use rear outpu
reduce curling).

l To prevent transparencies from sticking together, re
transparencies in the output tray as they are printed

l Place transparencies on a flat surface after removin
the printer. 
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Printing on Custom-Sized Media or Cardstock
Postcards, 3 by 5 in. (index) cards, and other custom-sized media can 
be printed from Tray 1. The minimum media size is 76 by 127 mm 
(3 by 5 in.) and the maximum media size is 216 by 356 mm (8.5 by 

edia with a 
that has been 
mance, make 
lease refer to 
 Using media 

ant to print in 
oftware. 
m.

.) or 127 mm 

edges of the 

ations.
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14 in.).

Note You may experience some paper jams when using any m
length less 178 mm (7 in.). This may be caused by paper 
effected by environmental conditions. For optimum perfor
sure you are storing and handling the paper correctly. P
“Printing and Paper Storage Environment” on page 144.
from another manufacturer may also help.

Custom-Sized Media and Cardstock Guidelines:

l Always insert the short-edge first into Tray 1. If you w
landscape mode, make this selection through your s
Inserting paper long-edge first may cause a paper ja

l Use the rear output tray to reduce curl.

l Do not print on media smaller than 76 mm wide (3 in
(5 in.) long.

l Set margins at least 6.4 mm (.25 in.) away from the 
media in the software application. 

See Appendix B starting on page 139 for media specific
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Printing on Both Sides of Media 
(Manual Duplexing)
l Print the first side of the media as you would normally. 

l Print the second side from Tray 1, making sure the printed side is 

r driver as 
es” and 
e rear output 
der. Print the 
e stack with 
 1. Close the 

 higher 
s. Using the 
ality may be 
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facing down with the top-edge toward the printer.

l The PS Windows 9x and the Windows NT 4.0 printe
well as some software applications include “odd pag
“even pages” printing. To use this option, flip down th
bin so that the paper will be stacked in the correct or
even pages first as you would normally. Next, put th
the blank side up, top-edge toward the printer in Tray
rear bin and print the odd pages.

Note When the second side is printing, you may experience a
frequency of paper misfeeds, paper jams, and multi-feed
rear output bin may reduce these problems. The print qu
different on the second side of the media. 
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Long and Short Edge Manual Duplexing

There are two ways to manually duplex, long edge or short edge 
binding. Long edge manual duplexing prints your document on both 
sides of the page with the binding on the long edge. Short edge 

dge. 

making sure 
 the printer. 

 making sure 
ard the 
EN Chapter 2 Print

duplexing prints the page with the binding on the short e

Long  edge binding : Print the second side from Tray 1, 
the printed side is facing down with the top-edge toward

Short edge binding : Print the second side from Tray 1,
the printed side is facing down with the bottom-edge tow
printer. 
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Printing on Special Media

Letterhead or Preprinted Forms Orientation

oward the 

-side down, 
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Tray 1 letterhead orientation:  print-side up, top-edge t
printer.

Tray 2 or optional Tray 3 letterhead orientation:  print
top-edge toward you.
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Canceling a Print Job

A print job can be stopped from a software application, a print queue, 
or the JOB CANCEL button.

el the job 
. 

oler such as 
 Mac, delete 

OB CANCEL 
 are already 
 print job. 

 job has been 
ter. Either 
uter has 
o light on). 

 printer. If 
L must be 
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l If the printer has not started printing, first try to canc
within the software application that sent the print job

l If the print job is waiting in a print queue or print spo
the Print Manager in Windows 3.1 or Print Monitor in
the job there. 

l If the print job is already printing, press the printer J
button. The printer will finish printing any pages that
moving through the printer and delete the rest of the

If the control panel status lights continue to cycle after a
canceled the computer is still sending the job to the prin
delete the job from the print queue or wait until the comp
finished sending data. The printer will return to Ready (G

Job Cancel Tips

Pressing JOB CANCEL cancels only the current job in the
more than one print job is in printer memory, JOB CANCE

pressed once for each job.
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Software Tasks

This section lists the common printing tasks that are controlled 
through the printer software. Some printer drivers do not support all 

advantage of 

gh the 
ough access 
 vary, the 

 matter which 

ality Settings
Source
lts
 Pages on 
per (N-up 
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printer features. Use the PCL 6 printer driver to take full 
all the printer’s features, including:

Accessing the Printer Driver
After installation, you can access the printer driver throu
operating system or from your software application. Alth
to the printer driver from your software applications may
printer driver is usually accessed from the File menu. 

Note The method for accessing a printer driver is the same, no
printer driver you are using.

l Watermarks l Quick Sets
l Custom Paper Size l Custom Print Qu
l EconoMode l Selecting Paper 
l Reduce/Enlarge l Restoring Defau
l Resolution Enhancement 

technology (REt) 
l Printing Multiple

One Sheet of pa
printing)
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d from the 
e detailed 
driver help is 

Accessing the Driver

Temporarily Change 
 Settings
cations)

n, point to 
lick Printers. 

er icon, and 
Many of the 
rinter drivers are 
Document 

control panel, 
s, highlight the 
tup.

, select Print, 
lick Save to 

, select Print. 
 options you 
k Save to save 
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Using the Printer Driver Help
Each printer driver has help screens that can be activate
Help button in the printer driver. These help screens giv
information about the specific driver being used. Printer 
separate from the software application help.

Operating System
Settings (from a software 
application)

Change Default
(across all appli

Windows 9x/NT 4.0 From the File menu, click Print, and 
then click Properties. (The actual 
steps can vary; this is the most 
common method.)

Click the Start butto
Settings, and then c
Right-click the print
choose Properties. 
features in NT 4.0 p
also located on the 
Defaults menu.

Windows 3.x From the File menu, click Print, click 
Printers, and then click Options. 
(The actual steps can vary; this is 
the most common method.)

From the Windows 
double-click Printer
printer, and click Se

Macintosh
LaserWriter 8.3

From the File menu, select Print, 
and click Options.

From the File menu
and click Options. C
save your changes.

Macintosh
LaserWriter 8.4 and higher

From the File menu, select Print. 
Click the pop-up for options you 
wish to change.

From the File menu
Click the pop-up for
wish to change. Clic
your changes.
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Creating and Using Watermarks
The Watermark options allow you to specify that text be placed 
“underneath” (in the background) of an existing document. For 
example, you may want to have large gray letters reading “draft” or 

ll pages of a 

s), Windows 

arks drop-down 

ct the 
ew.

.

Only, if desired.

” in the 
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“confidential” placed diagonally across the first page or a
document. 

Note Watermarks are available only with the HP PCL 6 (Window
NT 4.0 PS, and LaserWriter printer drivers.

Watermarks

Printer Driver Procedure

PCL 6 
(Windows 3.1/9x)

To use an existing watermark

1. Access the printer driver.

2. From the Effects tab, click the Waterm
list.

3. Click the desired watermark.

4. Click First Page Only, if desired.

5. Click OK.

To create or edit a watermark

1. Access the printer driver.

2. From the Effects tab, click Edit.

3. In the Watermark Details window, sele
watermark you want to edit, or click N

4. Select the desired watermark options

5. Click OK.

6. From the Effects tab, click First Page 

7. Click OK.

To stop printing the watermark, click “none
Watermarks drop-down list.
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s, then click 
d choose 

arks drop-down 

” in the 

e server, you 
rmarks.

s, then click 
d choose 

ct the 
ew.

.

Only, if desired.

” in the 

Watermarks (continued)

Printer Driver Procedure
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PCL 6 
(Windows NT 4.0)

To use an existing watermark

1. Click the Start button, point to Setting
Printers. Right-click the printer icon an
Document Defaults.

2. From the Effects tab, click the Waterm
list.

3. Click the desired watermark.

4. Click First Page Only, if desired.

5. Click OK.

To stop printing the watermark, click “none
Watermarks drop-down list.

To create or edit a watermark

If you are running the printer driver from th
need administrator rights to save new wate

1. Click the Start button, point to Setting
Printers. Right-click the printer icon an
Document Defaults.

2. From the Effects tab, click Edit.

3. In the Watermark Details window, sele
watermark you want to edit, or click N

4. Select the desired watermark options

5. Click OK.

6. From the Effects tab, click First Page 

7. Click OK.

To stop printing the watermark, click “none
Watermarks drop-down list.
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nt Options, then 
ntries.

ion (Watermark, 
termark Angle, 

k) and select the 

mark and select 
box.

s not support 
ate a 

r.

 each desired 
mark Font, 
atermark Style, 
esired setting 

mark and select 
box.

t support user-
 watermark, use 

.

ermark option 

 or “Printer’s 
p.

Watermarks (continued)

Printer Driver Procedure
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Windows NT 4.0 PS To use an existing watermark

1. Access the printer driver.

2. From the Advanced tab, click Docume
Printer Features to expand their sube

3. Click on each desired Watermark opt
Watermark Font, Watermark Size, Wa
Watermark Style, and Print Watermar
desired setting for each option.

4. Click OK.

To stop printing the watermark, click Water
“none” in the Change ‘Watermark’ Setting 

The Windows NT 4.0 PS printer driver doe
user-defined watermarks. If you want to cre
watermark, use the HP PCL 6 printer drive

Windows 9x PS To use an existing watermark

1. Access the printer driver.

2. From the Device Options tab, click on
Watermark option (Watermark, Water
Watermark Size, Watermark Angle, W
and Print Watermark) and select the d
for each option.

3. Click OK.

To stop printing the watermark, click Water
“none” in the Change ‘Watermark’ Setting 

The Windows 9x PS printer driver does no
defined watermarks. If you want to create a
the HP PCL 6 printer driver.

Macintosh
LaserWriter 8.3

1. Select Page Setup from the File menu

2. Select Options.

3. Click the pop-up for each desired wat
and select the desired setting.

4. Click OK.

To stop printing watermarks, select “None”
default” from the Watermark/Overlay pop-u
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.

k/Overlay.

n and select the 
 type text in the 

 in the layer 

Watermarks (continued)

Printer Driver Procedure
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Macintosh
LaserWriter 8.4 and 
higher

1. Select Page Setup from the File menu

2. Click the pop-up and select Watermar

3. Click on each desired watermark optio
desired setting. To use your own text,
custom text box.

4. Click print.

To stop printing watermarks, select “None”
option.
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Printing Multiple Pages on One Sheet of Paper 
(N-up Printing)
You can select the number of pages you want to print on a single 
sheet of paper. If you choose to print more than one page per sheet, 

n the sheet. 

r Sheet.

o print per sheet 

o print a border 
Page Borders is 
t to 2, 4, or 9.

r Sheet.

o print per sheet 

o print a border 
Page Borders is 
t to 2, 4, or 9.

p.
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the pages will appear decreased in size and arranged o
You can specify up to 9 pages.

N-up Printing

Printer Driver Procedure

PCL 6 
(Windows 3.1/9x)

1. Access the printer driver.

2. From the Finishing tab, click Pages pe

3. Enter the number of pages you want t
(1, 2, 4, or 9).

4. Click Print Page Borders if you want t
around each page on the sheet. Print 
enabled only if Pages per Sheet is se

5. Click OK.

PCL 6 
(Windows NT 4.0)

1. Access the printer driver.

2. From the Finishing tab, click Pages pe

3. Enter the number of pages you want t
(1, 2, 4, or 9).

4. Click Print Page Borders if you want t
around each page on the sheet. Print 
enabled only if Pages per Sheet is se

5. Click OK.

Windows 9x PS 1. Access the printer driver.

2. From the Paper tab, click 1-, 2-, or 4-u

3. Click OK.
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nt Options, then 
ntries.

, or 16) in the 
x.

atch the 
, a landscape 
ould use the 4 

.

, or 16).

N-up Printing (continued)

Printer Driver Procedure
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Windows NT 4.0 PS 1. Access the printer driver.

2. From the Advanced tab, click Docume
Printer Features to expand their sube

3. Click Pages per Sheet.

4. Select the desired option (1, 2, 4, 6, 9
Change ‘Pages per Sheet’ Setting bo

Select the Pages per Sheet orientation to m
orientation of your document. For example
presentation printed at 4 pages per sheet w
(Landscape) Pages per Sheet setting.

5. Click OK.

Macintosh
LaserWriter 8.3

1. Select Page Setup from the File menu

2. Select Layout.

3. Select the desired option (1, 2, or 4).

4. Click OK.

Macintosh
LaserWriter 8.4 and 
higher

1. Select Print from the File menu.

2. Select Layout.

3. Select the desired option (1, 2, 4, 6, 9

4. Click OK.
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Setting a Custom Paper Size
Use the Custom Paper feature to print on paper sizes other than 
standard sizes.

 type the name 

limeters or 

rge, the driver 

d width.

 for reuse.

port custom 
 through the 

s, then click 

erties.

 Form.

s.
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Custom Paper Size

Printer Driver Procedure

PCL 6 
(Windows 3.1/9x)

1. Access the printer driver.

2. From the Paper tab, click Custom.

3. From the Custom Paper Size window,
of the custom paper size.

4. Click the desired unit of measure (mil
inches).

If you enter a size that is too small or too la
will automatically adjust the size for you.

5. Enter the custom paper size length an

6. Click OK.

You can save up to five custom paper sizes

Windows NT 4.0 The Windows NT printer drivers do not sup
paper sizes. You may access custom sizes
operating system.

1. Click the Start button, point to Setting
Printers.

2. From the File menu, click Server Prop

3. From the Forms tab, click Create New

4. Set the custom paper size and margin

5. Click OK.
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 of the Paper 

w, type the 
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es for reuse.

.

per size. 
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k with Apple for 

.

age attributes 

es or select Edit 

Custom Paper Size (continued)

Printer Driver Procedure
EN Chapter 2 Print

Windows 9x PS 1. Access the printer driver.

2. From the Paper tab, scroll to the right
Size box and click Custom Page.

3. Click the Custom button.

4. From the Custom-Defined Size windo
name of the custom paper size.

5. Click the desired unit of measure (mil
inches).

6. Enter the custom paper size length an

7. Click OK.

You can save up to three custom paper siz

Macintosh
LaserWriter 8.3

1. Select Page Setup from the File menu

2. Select Custom.

3. Click the paper image to select the pa

Macintosh
LaserWriter 8.4

The 8.4 version does not support this optio
version to use custom paper sizes, or chec
updated drivers.

Macintosh
LaserWriter 8.5 and 
higher

1. Select Page Setup from the File menu

2. Select Custom page Sizes from the P
pop-up.

3. Select New to create custom page siz
for existing custom pages.

4. Click OK.
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Creating and Using Quick Sets
Quick Sets allow you to save the current driver settings (for example, 
page orientation, n-up printing or paper source) for reuse. For 
convenience, Quick Sets can be selected and saved from most 

fault settings 
t.

driver for 

r the selected 
rt” or “My 

t driver settings 
remember these 

k Sets drop-

nt according to 
cted.
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printer driver tabs. You can also restore printer driver de
by selecting Defaults from the Quick Sets drop-down lis

Note Quick Sets are available only with the HP PCL 6 printer 
Windows. 

Quick Sets

Printer Driver Procedure

PCL 6 
(Windows 3.1/9x)

Creating Quick Sets

1. Access the printer driver.

2. Select the desired print settings.

3. In the Quick Sets box, type a name fo
settings (for example “Quarterly Repo
Project Status”).

4. Click Save.

5. When you save Quick Sets, all curren
are saved. The printer driver will now 
settings. 

6. Click OK.

Using Quick Sets

1. Access the printer driver.

2. Select the desired item from the Quic
down list.

3. Click OK. The printer is now set to pri
the settings in the Quick Sets you sele
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Quick Sets (continued)

Printer Driver Procedure
EN Chapter 2 Print

PCL 6 
(Windows NT 4.0)

Creating Quick Sets

If you are running the printer driver from th
need administrator rights to save new Quic

1. Click the Start button, point to Setting
Printers. Right-click the printer icon an
Document Defaults. You can save Qu
any tab.

2. Select the desired print settings.

3. In the Quick Sets box, type a name fo
settings (for example “Quarterly Repo
Project Status”).

4. Click Save. When you save Quick Set
driver settings are saved. The printer 
remember these settings. 

5. Click OK.

Using Quick Sets

1. Access the printer driver.

2. Select the desired item from the Quic
down list.

3. Click OK.
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Using EconoMode
EconoMode (Save Toner) allows the printer to use less toner on each 
page. Selecting this option will extend the life of your toner cartridge 
and reduce your cost per page, but will reduce print quality. This 

de (Save 
ode is enabled. 
abled.

s, then click 
d choose 

de (Save 
ode is enabled. 
abled.

onoMode.

 in the Change 

nt Options, then 
ntries.

 in the Change 
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setting is not available with 1200 dpi settings.

EconoMode

Printer Driver Procedure

PCL 6 
(Windows 3.1/9x)

1. Access the printer driver.

2. From the Finishing tab, click EconoMo
Toner). If the box is checked, EconoM
If the box is empty, EconoMode is dis

3. Click OK.

PCL 6 
(Windows NT 4.0)

1. Click the Start button, point to Setting
Printers. Right-click the printer icon an
Document Defaults.

2. From the Finishing tab, click EconoMo
Toner). If the box is checked, EconoM
If the box is empty, EconoMode is dis

3. Click OK.

Windows 9x PS 1. Access the printer driver.

2. From the Device Options tab, click Ec

3. Select the desired EconoMode option
Setting in EconoMode drop-down list.

4. Click OK.

Windows NT 4.0 PS 1. Access the printer driver.

2. From the Advanced tab, click Docume
Printer Features to expand their sube

3. Click EconoMode.

4. Select the desired EconoMode option
‘EconoMode’ Setting box.

5. Click OK.
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.

elect Imaging 

the desired 

EconoMode (continued)

Printer Driver Procedure
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Macintosh
LaserWriter 8.3

1. Select Print from the File menu.

2. Click Options.

3. Select the desired EconoMode setting

4. Click OK.

Macintosh
LaserWriter 8.4 and 
higher

1. Select Print from the File menu.

2. Click the popup for print options and s
Options.

3. In the Imaging Options dialog, select 
EconoMode setting.

4. Click Print.
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Choosing Print Quality Settings
The printer’s default print quality setting is Best Quality, which uses 
1200 dpi to provide the best combination of print speed and print 
quality. If you need advanced print quality, you can choose custom 

uality.

mplex 

.

text.

then Details.

lect the desired 

s, then click 
d choose 

then Details.

lect the desired 

ired resolution 
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settings. 

Resolution Options:

l Best Quality  (default) - 1200 dpi for the best print q

l Faster Printing  - 600 dpi, alternate resolution for co
graphics or faster output. 

l Custom  - Allows you to specify print quality settings

Note Changing resolution may change the formatting of your 

Choosing Print Quality Settings

Printer Driver Procedure

PCL 6 
(Windows 3.1/9x)

1. Access the printer driver.

2. From the Finishing tab, click Custom, 

3. In the Print Quality Details window, se
resolution setting.

4. Click OK.

PCL 6 
(Windows NT 4.0)

1. Click the Start button, point to Setting
Printers. Right-click the printer icon an
Document Defaults.

2. From the Finishing tab, click Custom, 

3. In the Print Quality Details window, se
resolution setting.

4. Click OK.

Windows 9x PS 1. Access the printer driver.

2. From the Graphics tab, select the des
setting.

3. Click OK.
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Choosing Print Quality Settings (continued)

Printer Driver Procedure
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Windows NT 4.0 PS 1. Access the printer driver.

2. From the Advanced tab, click Graphic
subentries.

3. Click Resolution.

4. Select the desired Resolution option i
‘Resolution’ Setting box. (1200 is the 
quality in the PCL 6 printer driver.)

5. Click OK.

Macintosh
LaserWriter 8.3

1. Select Print from the File menu.

2. Click Options.

3. In the Print Options dialog, select the 
Resolution setting.

4. Click OK.

Macintosh
LaserWriter 8.4 and 
higher

1. Select Print from the File menu.

2. Click the pop-up for print options and 
Resolution Options.

3. In the Resolution Options dialog box, 
desired setting.

4. Click Print.
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Using Reduce/Enlarge Options
Reduce/Enlarge options allow you to scale your document to a 
percent of its normal size. You can also choose to scale your 
document to fit on letter- or A4-size paper.

age by which 
cument or click 
.
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age by which 
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ntage by which 
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per

 to Page.
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Reduce/Enlarge

Printer Driver Procedure

PCL 6 
(Windows 3.1/9x)

1. Access the printer driver.

2. From the Effects tab, type the percent
you want to reduce or enlarge your do
Fit to Letter Size or click Fit to A4 Size

3. Click OK.

PCL 6 
(Windows NT 4.0)

1. Click the Start button, point to Setting
Printers. Right-click the printer icon an
Document Defaults.

2. From the Effects tab, type the percent
you want to reduce or enlarge your do

3. Click OK.

Windows 9x PS To reduce or enlarge your document

1. Access the printer driver.

2. From the Graphics tab, type the perce
you want to reduce or enlarge your do
Scaling box.

3. Click OK.

To fit your document to letter- or A4-size pa

1. Access the printer driver.

2. From the Device Options tab, click Fit

3. Select the desired Fit to Page option i
Setting for: drop-down list.

4. Click OK.
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Reduce/Enlarge (continued)

Printer Driver Procedure
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Windows NT 4.0 PS To reduce or enlarge your document

1. Access the printer driver.

2. From the Advanced tab, click Graphic
subentries.

3. Click Scaling.

4. Type the percentage by which you wa
enlarge your document in the Change
Setting box.

5. Click OK.

To fit your document to letter- or A4-size pa

This setting works for all paper sizes in the 
PS printer driver.

1. Access the printer driver.

2. From the Advanced tab, click Docume
Printer Features to expand their sube

3. Click Fit to Page.

4. Select the desired option in the Chan
Setting box.

5. Click OK.

Macintosh
LaserWriter 8.3

1. Select Page Setup from the File menu

2. Select Reduce/Enlarge.

3. Select the desired settings. 

4. Click OK.

Macintosh
LaserWriter 8.4 and 
higher

1. Select Page Setup from the File menu

2. Select Scale.

3. Select the desired settings. 

4. Click OK.



EN

Selecting a Paper Source
If your application supports printing paper by source, make the 
selections from your application. Application settings override printer 
driver settings.

 Source of 

s, then click 
d choose 

 Source of 

 Paper Source 
 list.

esired paper 
own list.
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Selecting Paper Source

Printer Driver Procedure

PCL 6 
(Windows 3.1/9x)

1. Access the printer driver.

2. From the Paper tab, select the desired
paper.

3. Click OK.

PCL 6 
(Windows NT 4.0)

1. Click the Start button, point to Setting
Printers. Right-click the printer icon an
Document Defaults.

2. From the Paper tab, select the desired
paper.

3. Click OK.

Windows 9x PS 1. Access the printer driver.

2. From the Paper tab, select the desired
option in the Paper Source drop-down

3. Click OK.

Windows NT 4.0 PS 1. Access the printer driver.

2. From the Page Setup tab, select the d
source from the Paper Source drop-d

3. Click OK.

Macintosh
LaserWriter 8.3

1. Select Print from the File menu.

2. Choose paper source.

3. Select the desired selection.

4. Click OK.

Macintosh
LaserWriter 8.4 and 
higher

1. Select Print from the File menu.

2. Click the Paper Source pop-up. 

3. Select the desired source.

4. Click Print.
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Using REt
When REt (Resolution Enhancement technology) is on, it refines the 
print quality of characters by smoothing out jagged edges that can 
occur on the angles and curves of a printed image. Choose Off if 

learly.

then Details.

lect the REt 
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d choose 

then Details.

lect the REt 

nt Options, then 
ntries.

ement option in 
t’ Setting box.
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graphics, particularly scanned images, are not printing c

Note REt is disabled when 1200 dpi settings are selected.

REt

Printer Driver Procedure

PCL 6 
(Windows 3.1/9x)

1. Access the printer driver.

2. From the Finishing tab, click Custom, 

3. In the Print Quality Details window, se
desired option (On or Off).

4. Click OK.

PCL 6 
(Windows NT 4.0)

1. Click the Start button, point to Setting
Printers. Right-click the printer icon an
Document Defaults.

2. From the Finishing tab, click Custom, 

3. In the Print Quality Details window, se
desired option (On or Off).

4. Click OK.

Windows NT 4.0 PS 1. Access the printer driver.

2. From the Advanced tab, click Docume
Printer Features to expand their sube

3. Click Resolution Enhancement.

4. Select the desired Resolution Enhanc
the Change ‘Resolution Enhancemen

5. Click OK.
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REt (continued)

Printer Driver Procedure
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Windows 9x PS 1. Access the printer driver.

2. From the Device Options tab, select th
Resolution Enhancement option from
Features drop-down list.

3. Select the desired Resolution Enhanc
the Change setting for ‘Resolution En
drop-down list.

4. Click OK.

Macintosh
LaserWriter 8.3

1. Select Print from the File menu.

2. Click Options.

3. In the Print Options dialog, select the
Resolution Enhancement setting. 

4. Click OK.

Macintosh
LaserWriter 8.4 and 
higher

1. Select Print from the File menu.

2. Click the pop-up for print options and 
Resolution Options.

3. In the Resolution Options dialog box, 
desired Resolution Enhancement sett

4. Click Print.
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Restoring Default Printer Driver Settings

Restoring Defaults
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d choose 
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Printer Driver Procedure

PCL 6 
(Windows 3.1/9x)

1. Access the printer driver.

2. In the Quick Sets box, click Defaults 

PCL 6 
(Windows NT 4.0)

1. Click the Start button, point to Setting
Printers. Right-click the printer icon an
Document Defaults.

2. In the Quick Sets box, click Defaults 

Windows 9x PS 1. Access the printer driver.

2. Click the Restore Defaults button for e
you want to restore default settings.

Windows NT 4.0 PS The Windows NT 4.0 PS printer driver invo
settings when an application is started. To 
printer settings without restarting your app
another printer driver, then select the Wind
printer driver.

Macintosh
LaserWriter 8.3

To restore default printer driver settings, de
“LaserWriter 8 Prefs” file in the Preference
System folder. 

Macintosh
LaserWriter 8.4 and 
higher

1. Open the Preferences folder.

2. Open the Printing Prefs folder.

3. Open the Parsed PPD folder.

4. In the Parsed PPD Folder, delete the 
same name as the printer. For examp
called HP LaserJet 2100 M, delete th
HP LaserJet 2100 M.PPD in the follow
HD:System Folder:Preferences:Printi
PPD Folder:HP LaserJet 2100 M
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Printing on Different Paper for the First Page 

Note Printing on different paper for the first page of a print job is available 
only with the HP PCL 6 printer and Macintosh LaserWriter driver. 

th the 

 paper for the 

.

e other pages of 
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d choose 

 paper for the 

.

e other pages of 
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Some applications may also have this feature. Check wi
application’s help file.

Printing on Different Paper for the First Page

Printer Driver Procedure

PCL 6 
(Windows 3.1/9x)

1. Access the printer driver.

2. From the Paper tab, select the desired
first page of your print job.

3. Click Use different paper for first page

4. Click the Other Pages tab.

5. Select the desired paper source for th
your print job.

PCL 6 
(Windows NT 4.0)

1. Click the Start button, point to Setting
Printers. Right-click the printer icon an
Document Defaults.

2. From the Paper tab, select the desired
first page of your print job.

3. Click Use different paper for first page

4. Click the Other Pages tab.

5. Select the desired paper source for th
your print job. 
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Printing on Different Paper for the First Page (continued)

Printer Driver Procedure
EN Chapter 2 Print

Note The paper size for all pages of the print job must be the
driver.

Macintosh
LaserWriter 8.3

1. Select Print from the File menu.

2. Select First From and then select the 
the first page from the pop-up menu.

3. Select the tray for the rest of the job fr
Remaining From pop-up menu.

Macintosh
LaserWriter 8.4 and 
higher

1. Select Print from the File menu.

2. Select First Page From and then sele
tray for the first page from the pop-up

3. Select the tray for the rest of the job fr
Remaining From pop-up menu.
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Tray Locking
Tray Locking is a feature that allows you to “lock” a tray so that the 
only time the printer will draw from that tray is when it is specifically 
requested. This is useful when you want to put special paper in a tray, 

vailable 
er will only 
ray 3, if it is 
must specify 

ay must be 

ility or JetAdmin.

ou wish to lock.

Trays.
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such as letterhead. For example, if you are using “First A
Tray,” for the paper source and you lock Tray 1, the print
draw from the remaining trays, either Tray 2 or optional T
installed. You can still print from the locked tray, but you 
the source.

Note The feature will not allow you to lock all the trays. One tr
“unlocked.”

Tray Locking

Printer Utility Procedure

Windows 1. Run the HP LaserJet configuration ut

2. From the Custom tab, select the tray y

Macintosh 1. Run the HP LaserJet Utility.

2. From the Settings Panel, select Input 

3. Click on the tray you want to lock.
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3 Printer Tips and 
Maintenance 

conomical 
ner cartridge 
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Overview

This chapter provides suggestions for high-quality and e
printing. It also lists special maintenance tasks for the to
and the printer. 

l Managing the UltraPrecise Toner Cartridge

l Redistributing the Toner

l Cleaning the Printer

l Using the Printer Cleaning Processes
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Managing the UltraPrecise Toner Cartridge

HP Policy on Non-HP Toner Cartridges
on-HP toner 
use they are 
ntrol their 

l you are 
d package is 
n opened 

 it to light for 

f toner that 
 HP LaserJet 
his assumes 
e are the 

 cartridge, 
e box.
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Hewlett-Packard Company cannot recommend use of n
cartridges, either new, refilled, or remanufactured. Beca
not HP products, HP cannot influence their design or co
quality.

Toner Cartridge Storage
Do not remove the toner cartridge from its package unti
ready to use it. The shelf life of a cartridge in an unopene
approximately 2.5 years. The shelf life of a cartridge in a
package is approximately 6 months.

CAUTION To prevent damage to the toner cartridge, do not expose
more than a few minutes.

Toner Cartridge Life Expectancy
The life of the toner cartridge depends on the amount o
print jobs require. When printing text at 5% coverage, an
2100 toner cartridge lasts an average of 5,000 pages. T
the print density is set to 3 and EconoMode is off. (Thes
default settings.)

Recycling Toner Cartridges
To install a new HP toner cartridge and recycle the used
follow the instructions included in the new toner cartridg

See “HP Toner Cartridges” on page 133.
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Redistributing the Toner

When toner is low, faded or light areas 
ge. You may 

ove print 
 toner. The 
low you to 
efore 
e.

ridge from 

he printer. 
ay be hot!

 expose the 
ore than a 

dge and 
 to side to 
Do not tip the 
might leak.)

1

EN Chapter 3 Printer Tips and Ma

may appear on a printed pa
be able to temporarily impr
quality by redistributing the
following procedure may al
finish the current print job b
replacing the toner cartridg

1 Open the top cover. 

2 Remove the toner cart
the printer. 

WARNING!
Avoid reaching too far into t
The adjacent fusing area m

CAUTION
To prevent damage, do not
toner cartridge to light for m
few minutes. 

3 Rotate the toner cartri
gently shake from side
redistribute the toner. (
cartridge on end, or it 

Continued on next page.

2

3
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Note
g, wipe it off 
othing in cold 
r into fabric.)
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p cover.

tall a new 
 instructions 
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If toner gets on your clothin
with a dry cloth and wash cl
water. (Hot water sets tone

4 Reinsert the toner cart
printer and close the to

If the print remains light, ins
toner cartridge. (Follow the
provided with the new tone
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Cleaning the Printer

To maintain print quality, follow the cleaning procedures on the 
following pages every time the toner cartridge is changed or 

ible, keep the 

ampened 

rinter. While 
oller (located 
n cause print 

les can 
n cause print 
s printer has 
types of 

rint the page 

ove dust and 
periencing 

ide a blank 
ing Process” 

 Use this 
ed printouts. 
e Cleaning 
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whenever print quality problems occur. As much as poss
printer free from dust and debris.

l Clean the outside of the printer with a lightly water-d
cloth.

l Clean the inside with a dry, lint-free cloth.

CAUTION Do not use ammonia-based cleaners on or around the p
cleaning the printer, be careful not to touch the transfer r
underneath the toner cartridge). Skin oils on the roller ca
quality problems. 

Using the Printer Cleaning Processes
During the printing process, paper, toner and dust partic
accumulate inside the printer. Over time, this buildup ca
quality problems such as toner specks or smearing. Thi
two cleaning modes that can correct and prevent these 
problems. 

Note In order for the engine cleaning page to work properly, p
on copier-grade paper, not bond or rough paper.

Engine Cleaning

This process uses copier-grade paper from Tray 2 to rem
toner from the paper path. Use this process if you are ex
toner specks or dots on printouts. This process will prov
page which should be discarded. See “Starting the Clean
on page 74.

Toner Cartridge Cleaning 

This process cleans the drum inside the toner cartridge.
process if you are experiencing blurred, faded or smear
This process will take about 10 minutes. See “Starting th
Process” on page 74.
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Note Make sure the toner cartridge is not empty when using the toner 
cartridge cleaning. A near empty toner cartridge may also cause print 
defects. This 10-minute process consumes toner and if used often can 
reduce toner cartridge life. 

state. Make 

 all lights 
buttons when 

leaning 

 To stop the 
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Starting the Cleaning Process
1. Make sure the printer is turned on and in the ready 

sure there is paper loaded in Tray 2.

2. Press and hold the Go and Job Cancel buttons until
flash. This will take about 10 seconds. Release the 
the lights flash.

3. For engine cleaning, press the Go button,
or
for cartridge cleaning, press the Job Cancel button.

4. Discard the blank page produced from the engine c
process.

Note The cartridge cleaning process takes about 10 minutes.
toner cartridge cleaning process, turn the printer off.
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Internal Cleaning Procedure 
Over time, particles of toner and paper 
will begin to accumulate inside the 
printer. This may cause print quality 

leaning the 
ce these 

 turn the 
ower cable.

ridge.

 expose the 
ore than a 
of paper over 
e to shield it 

th, wipe any 
r path area 
 cavity. 

ridge and 
ug in the 
the printer 
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problems during printing. C
printer will eliminate or redu
problems.

WARNING!
Before cleaning the printer,
printer off and unplug the p

1 Open the top cover. 

2 Remove the toner cart

CAUTION
To prevent damage, do not
toner cartridge to light for m
few minutes. Place a piece 
the top of the toner cartridg
while it is out of the printer.

3 With a dry, lint-free clo
residue from the pape
and the toner cartridge

4 Replace the toner cart
close the top cover. Pl
power cable, and turn 
on. 

2

3

4
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4 Problem Solving

the following 
EN Chapter 4 Proble

Overview

This chapter helps you troubleshoot printer problems in 
areas:

l Troubleshooting Checklist

l Troubleshooting General Printing Problems

l Printing Special Pages

l Clearing Paper Jams

l Solving Print Quality Problems

l Infrared Printing Problems

l Troubleshooting Error Messages

l Secondary Light Patterns

l Network Problems

l Common Windows Problems

l Common Macintosh Problems

l Troubleshooting PS Errors
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Troubleshooting Checklist 

If the printer is not responding properly, complete the following 
checklist in order. If the printer does not pass a step, follow the 

ord 
. Check the 

er outlet.

hooting Error 

 the paper 

“Clearing Paper 

or message, go 
 on page 99.

to “Solving Print 
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corresponding troubleshooting suggestions.

Troubleshooting Checklist

Make sure the printer 
Ready light is on.

If no lights are on, check the power c
connections. Check the power switch
power source by plugging into anoth

If other lights are on, go to “Troubles
Messages” on page 99.

Press GO to print a 
demo page to verify 
that the printer is 
feeding paper correctly.

If a demo page does not print, check
supply in Tray 2 or Tray 3. 

If the page jams in the printer, go to 
Jams” on page 85.

If the printer prints, but you get an err
to “Troubleshooting Error Messages”

Check the demo page 
to see if it printed 
correctly.

If there is a print quality problem, go 
Quality Problems” on page 91.
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Print a short document 
from a software 

If the page does not print, check the cable 
connection between the printer and computer. Make 

r (print monitor 
 paused.

ke sure you are 
rt.

ing, go to 
oblems” on 

oblems” on 

 97
 page 99

102

ge 108
age 110
 114

Troubleshooting Checklist (continued)
EN Chapter 4 Proble

application to verify the 
computer and printer 
are connected and are 
communicating 
correctly.

sure you are using the proper cable.

Check the print queue or print spoole
in Mac) to see if the printer has been

Check the software application to ma
using the proper printer driver and po
If the page is interrupted during print
“Troubleshooting General Printing Pr
page 80.

If completing the 
checklist did not 
diagnose the problem 
with the printer, check 
the following 
troubleshooting 
sections:

“Troubleshooting General Printing Pr
page 80
“Infrared Printing Problems” on page
“Troubleshooting Error Messages” on
“Secondary Light Patterns” on page 
“Network Problems” on page 107
“Common Windows Problems” on pa
“Common Macintosh Problems” on p
“Troubleshooting PS Errors” on page
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Troubleshooting General Printing Problems

re 
 paper tray 
d under the 
u within the 

dia in other 
 printer select 
 tray.

se the 
o change the 
y.

plexity of the 
sting the print 
If this problem 
y, add memory 

er cartridge 
sealing tape. 
ner cartridge. 
r by pressing 

mo page. 

ke sure that it 
 blank pages.
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Troubleshooting General Printing Problems

Symptom Possible Cause Solution

Printer selects media from the 
wrong tray.

The tray selection in the 
software application may be 
incorrect.

For many softwa
applications, the
selection is foun
Page Setup men
application.

Remove any me
trays to make the
from the desired

For Macintosh, u
LaserJet Utility t
priority of the tra

Print job is extremely slow. The job may be very complex.

The maximum speed of 10 
pages per minute cannot be 
exceeded even when more 
memory is added.

Reduce the com
page or try adju
quality settings. 
occurs frequentl
to the printer.

Pages print, but are totally 
blank.

The sealing tape may still be in 
the toner cartridge. 

Remove the ton
and pull out the 
Re-install the to
Check the printe
GO to print a de

The file may have blank 
pages. 

Check file to ma
does not contain
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arallel cable 
. Try a print job 
. If possible, 
 and printer to 
er and try a 
 know works. 
 IEEE-1284 

 or a LocalTalk 

rinter from 
 attach it 
puter with a 
rint a job that 
. If it prints 
with your 
trator.

are’s printer 
to make sure 
rJet 2100 is 

 from another 

indows (any 
a DOS prompt 
nality with the 
nd: At a 
Dir LPT1
. (This 
e connected to 
 light comes 
 button to 
e page.

y 1 and press 
Go button.

Troubleshooting General Printing Problems (continued)

Symptom Possible Cause Solution
EN Chapter 4 Proble

The printer prints, but the text 
is wrong, garbled, or 
incomplete.

The parallel cable is loose or 
defective.

Disconnect the p
and reconnect it
you know works
attach the cable
another comput
print job that you
Finally, try a new
compliant cable
cable (Mac).

The printer is on a network or 
sharing device and is not 
receiving a clear signal.

Disconnect the p
the network and
directly to a com
parallel cable. P
you know works
properly, check 
network adminis

The wrong driver was selected 
in the software.

Check the softw
selection menu 
that the HP Lase
selected.

The software application is 
malfunctioning.

Try printing a job
application.

The operating system is 
malfunctioning.

If printing from W
version), exit to 
and verify functio
following comma
C:\prompt, type 
then press enter
assumes you ar
LPT1). If the Go
on, press the Go
print and eject th

The printer does not respond 
when “print” is selected in the 
software.

The printer may be in manual 
feed mode (Go Light Blinking).

Add paper to Tra
and release the 



EN

reconnect the 

h the cable to 
er and print a 
rks. You may 

different 
EE-1284 
calTalk cable 

are printer 
to make sure 
rJet 2100 is 

are’s printer 
to make sure it 
 correct port. If 
s more than 

t, make sure 
ched to the 

rinter from 
 attach it 
puter with a 
rint a job you 
 prints 
with your 
trator.

n, check the 
ections. 
r switch. 
r source. 

Troubleshooting General Printing Problems (continued)

Symptom Possible Cause Solution
82  Chapter 4 Problem Solving

The parallel cable between the 
computer and the printer is not 
connected properly.

Disconnect and 
parallel cable.

The parallel cable is defective. If possible, attac
another comput
job you know wo
also try using a 
parallel cable (IE
Compliant) or Lo
(Mac).

The wrong printer was 
selected in the software.

Check the softw
selection menu 
that the HP Lase
selected.

. The software for the printer is 
not configured for the printer 
port.

Check the softw
selection menu 
is accessing the
the computer ha
one parallel por
the printer is atta
correct one.

The printer is on a network 
and is not receiving a signal.

Disconnect the p
the network and
directly to a com
parallel cable. P
know works. If it
properly, check 
network adminis

The printer is not receiving 
power.

If no lights are o
power cord conn
Check the powe
Check the powe
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 on the printer 
he printer is 
or.

 printer.

ray 2 or 
re pushed in 

ver securely.

ner cartridge 
emoving the 
-installing it.

aper Jams” on 

Troubleshooting General Printing Problems (continued)

Symptom Possible Cause Solution
EN Chapter 4 Proble

The printer does not respond 
when “print” is selected in the 
software.

The printer is malfunctioning. Check the lights
to determine if t
indicating an err

The Attention light stays on. The printer is out of paper. Add paper to the

Paper trays are installed 
incorrectly.

Make sure that T
optional Tray 3 a
all the way.

The Attention light is blinking The top cover of the printer is 
open.

Close the top co

The toner cartridge is missing 
or not installed correctly.

Make sure the to
is installed. Try r
cartridge and re

There is a paper jam in the 
printer.

See “Clearing P
page 85.



EN

Printing Special Pages

There are special pages within the memory of the printer that will help 
you to diagnose and learn about problems with your printer.

rinter is 

 and 
 press and 
 when the 
ond page will 

er Cartridge 
 path and the 
a blank page 
g Processes” 

r the 
84  Chapter 4 Problem Solving

Demo Page
To print the demo page, press the GO button when the p
ready.

Configuration Page
The configuration page lists many of the current settings
properties of the printer. To print the configuration page,
release the GO and JOB CANCEL buttons simultaneously
printer is ready. If you have an EIO card installed, a sec
print listing all of the EIO information.

Cleaning Process
The printer has two cleaning processes, Engine and Ton
cleaning. These clean internal areas including the paper
toner cartridge. The Engine cleaning process produces 
that should be discarded. See “Using the Printer Cleanin
on page 73.

Font List
To print a font list, use either HP FontSmart (Windows) o
HP LaserJet Utility (Macintosh). 



m Solving  85

Clearing Paper Jams 

Occasionally, paper can become jammed during a print job. Some of 
the causes include:

b.

. See “Media 

used. See 

ns on the 
vious, look 

. This should 
” on page 94.
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l Paper trays loaded improperly or overfilled.

l Tray 2 or optional Tray 3 is removed during a print jo

l Top cover is opened during a print job.

l Media that does not meet HP specifications is used
Specifications” on page 139.

l Media that is outside of the supported size range is 
“Media Specifications” on page 139.

Find and remove the jammed paper using the instructio
following pages. If the location of the paper jam is not ob
first in the toner cartridge area. 

Paper jams can occur at three locations:

l Tray 2 or optional Tray 3 paper feed area. 

l Toner cartridge area.

l Output areas. 

Note Loose toner may remain in the printer after a paper jam
clear after a few sheets have printed. See “Loose Toner
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Paper Jam: Toner 

y result in 
you get any 
 them in cold 
ill set the 

ridge.

 expose the 
ore than a 
of paper over 
e to shield it 

istration 
ge of the 
 pull the 
of the printer 
rinter.

1
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Cartridge Area 

1 Open the top cover. 

CAUTION
Paper jams in this area ma
loose toner on the page. If 
toner on your clothes, wash
water because hot water w
toner into the fabric.

2 Remove the toner cart

CAUTION
To prevent damage, do not
toner cartridge to light for m
few minutes. Place a piece 
the top of the toner cartridg
while it is out of the printer.

3 Carefully lift up the reg
plate. If the leading ed
paper is visible, gently
paper toward the rear 
to remove it from the p

Continued on next page.

3

2
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Note
 remove or 

tput area, 
d for the 

er has been 
wn the 

lace the toner 
 top cover.

cult to re-
tration plate 
 into 

ot go out, 
inside the 
d or output 

4
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If the paper is too difficult to
has already entered the ou
remove the jam as describe
output areas on page 89.

4 When the jammed pap
removed, gently flip do
registration plate. Rep
cartridge and shut the

Note
If the toner cartridge is diffi
install, make sure the regis
has been flipped back down
position.

If the Attention light does n
there is still jammed paper 
printer. Check the paper fee
areas.
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Paper Jam: Tray 2 or 

er Feed 

er cartridge 
 on page 86. 
 from the 
e paper feed 

ose the 

per by 
ible edge. 
e paper is 
ay 3 is 

misfed paper 
 of the paper 

 in the paper 
be accessed 
e area, grasp 
y pull it free 

to lock the 
to place and 
 the printer.

ot go out, 
inside the 
tridge and 
 jams.

1
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Optional Tray 3 Pap
Area 

Note
If paper has entered the ton
area, follow the instructions
It is easier to remove paper
toner cartridge area than th
area.

1 Slide out Tray 2 to exp
jammed paper. 

2 Remove any misfed pa
pulling it out by the vis
Make sure that all of th
aligned in the tray. If Tr
installed, remove any 
and make sure that all
is aligned in that tray. 

3 If the paper is jammed
feed area and cannot 
from the toner cartridg
the paper and carefull
from the printer. 

4 Push the paper down 
metal paper lift plate in
slide the tray back into

Note
If the Attention light does n
there is still jammed paper 
printer. Check the toner car
rear output areas for paper

 

2

3

4
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Paper Jam: Output Areas 

y result in 
you get any 
 them in cold 
ill set the 

d remove the 
the rear 

top cover in 
tput gearing 

he paper is 
ible in the 

ly pull the 
 printer from 

g using both 
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 the printer.

ompletely 
tput bin, pull 
refully out of 

rtridge. 
d the rear 

ot go out, 
inside the 
d and the 
per jams.

1
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CAUTION
Paper jams in this area ma
loose toner on the page. If 
toner on your clothes, wash
water because hot water w
toner into the fabric.

1 Open the top cover an
toner cartridge. Open 
output bin.

Note
It is necessary to open the 
order to release the rear ou
for easy paper removal.

2 If the leading edge of t
not visible or barely vis
cartridge area, careful
leading edge out of the
the rear output openin
hands. Carefully remo
the jammed paper from

3 If the paper is almost c
visible from the top ou
the remaining paper ca
the printer. 

4 Re-install the toner ca
Close the top cover an
output bin.

Note
If the Attention light does n
there is still jammed paper 
printer. Check the paper fee
toner cartridge areas for pa

3

2

4
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Paper Jam: Removing Torn 

ed paper can 
se the 

ve any small 
rinter.

artridge is 
 is closed, 
l Tray 3 (if 
ly pushed 

 then back 
rts, the 
 piece(s) of 

d remove the 
the rear 

f paper. 

ved by hand, 
einstall the 
 paper has 
p cover and 

1

90  Chapter 4 Problem Solving

Pieces of Paper 

Sometimes a piece of jamm
tear when being removed. U
following procedure to remo
pieces of paper left in the p

1 Make sure the toner c
installed, the top cover
and Tray 2 and optiona
installed) are complete
into the printer.

2 Turn the printer off and
on. As the printer resta
rollers will advance the
paper.

3 Open the top cover an
toner cartridge. Open 
output bin.

4 Remove the piece(s) o

If the paper cannot be remo
repeat steps 1 through 4. R
toner cartridge when all the
been removed. Close the to
the rear output bin.

2

3

4
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Solving Print Quality Problems 

Print Quality Checklist 
g the 

 the best 

ge 71).

 58).

re (see page 

ge 80). 

ality again. 
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General print quality problems can be solved by followin
checklist below. 

l Check the printer driver to make sure you are using
available print quality option (see page 58).

l Redistribute the toner in the toner cartridge (see pa

l Clean the inside of the printer (see page 73).

l Check the paper type and quality (see page 139).

l Adjust the print density from the software (see page

l Check to make sure EconoMode is off in the softwa
56).

l Troubleshooting General Printing Problems (see pa

l Install a new HP toner cartridge, then check print qu
See instructions provided with the toner cartridge.
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Image Defect Examples 
The examples below depict letter-size paper that has passed through 
the printer short-edge first. The following pages list the typical cause 
and solution for each of these examples.

l Repetitive 
efects

l Lines

les or 
ses
92  Chapter 4 Problem Solving

Light Print or 
Fade

Vertica
D

Misformed 
Characters

Vertica

Toner SmearGray 
Background

Dropouts

Page Skew

Toner Specks

Curl or Wave Wrink
Crea

Loose Toner
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Light Print or Fade

If a vertical white streak or faded area appears on the page:

l The toner supply is low. You may be able to temporarily extend 
” on page 71. 
 HP toner 

for example, 
ecifications” 

nt is too light 
nd 
conoMode” 

dicate that 
Cleaning” on 

for example, 
ecifications” 

ing 

eaning” on 

e page:

ting the job.

paper has 
t source. See 

can cause 
nd of paper. 

Repetitive 

 HP- 
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the toner cartridge life. See “Redistributing the Toner
If this does not improve the print quality, install a new
cartridge.

l The paper may not meet HP’s paper specifications (
the paper is too moist or too rough). See “Media Sp
on page 139.

l If the whole page is light, the print density adjustme
or EconoMode may be on. Adjust the print density a
EconoMode within the software driver. See “Using E
on page 56.

l A combination of faded and smeared defects may in
the cartridge needs cleaning. See “Toner Cartridge 
page 73.

Toner Specks
l The paper may not meet HP’s paper specifications (

the paper is too moist or too rough). See “Media Sp
on page 139.

l The transfer roller may be dirty. See “Internal Clean
Procedure” on page 75.

l The paper path may need cleaning. See “Engine Cl
page 73.

Dropouts 

If faded areas, generally rounded, occur randomly on th

l A single sheet of paper may be defective. Try reprin

l The moisture content of the paper is uneven or the 
moist spots on its surface. Try paper from a differen
“Media Specifications” on page 139.

l The paper lot is bad. The manufacturing processes 
some areas to reject toner. Try a different kind or bra
See “Media Specifications” on page 139.

l The toner cartridge may be defective. See “Vertical 
Defects” on page 95.

l If these steps do not correct the problem, contact an
authorized dealer or service representative.



EN

Vertical Lines 

If black or white vertical streaks appear on the page:

l The photosensitive drum inside the toner cartridge has probably 
been scratched. Install a new HP toner cartridge.

acceptable, 
ondition:

 amount of 

dia 

dity) 
hading.

aper, the 
dure” on 

dicate that 
Cleaning” on 

ifications” on 

g Procedure” 

ifications” on 
94  Chapter 4 Problem Solving

Gray Background 

If the amount of background toner shading becomes un
the procedures described below may help to clear the c

l Decrease the density setting. This will decrease the
background shading.

l Change the paper to a lighter basis weight. See “Me
Specifications” on page 139.

l Check the printer’s environment; very dry (low humi
conditions can increase the amount of background s

l Install a new HP toner cartridge.

Toner Smear 
l If toner smears appear on the leading edge of the p

paper guides are dirty. See “Internal Cleaning Proce
page 75.

l A combination of faded and smeared defects may in
the cartridge needs cleaning. See “Toner Cartridge 
page 73.

l Check the paper type and quality. See “Media Spec
page 139.

l Try installing a new HP toner cartridge.

Loose Toner
l Clean the inside of the printer. See “Internal Cleanin

on page 75.

l Check the paper type and quality. See “Media Spec
page 139.

l Try installing a new HP toner cartridge.
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Vertical Repetitive Defects 

If marks repeatedly appear on the printed side of the page at even 
intervals:

l The toner cartridge may be damaged. The circumference of the 
 mark occurs 
 toner 

 occur on the 
f after a few 

HP-approved 

 images, the 
ee “Media 

vy effect, the 
ccurs on a 
y. If you need 
 
nty 

ifications” on 

ctly and that 
paper stack.

ature and 
tions” on 

ing the paper 

t bin. 
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toner cartridge drum is 94 mm (3.7 in.). If a repetitive
every 94 mm (3.7 in.) on the page, install a new HP
cartridge.

l Internal parts may have toner on them. If the defects
back of the page, the problem will likely correct itsel
more pages.

l The fusing assembly may be damaged. Contact an 
service technician.

Misformed Characters 
l If characters are improperly formed, producing hollow

paper stock may be too slick. Try a different paper. S
Specifications” on page 139.

l If characters are improperly formed, producing a wa
laser scanner may need service. Verify that it also o
demo page by pressing GO when the printer is read
service, contact an HP-authorized dealer or service
representative. See “Hewlett-Packard Limited Warra
Statement” on page 121.

Page Skew
l Check the paper type and quality. See “Media Spec

page 139.

l Make sure the paper or other media is loaded corre
the guides are not too tight or too loose against the 

Curl or Wave
l Check the paper type and quality. Both high temper

humidity will cause paper curl. See “Media Specifica
page 139.

l Turn over the stack of paper in the tray. Also try rotat
180° in the input tray.

l Open the rear door and try printing to the rear outpu
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Wrinkles or Creases
l Make sure that paper is loaded properly.

l Check the paper type and quality. See “Media Specifications” on 
page 139.

t bin. 

g the paper 

 the sealing 
t the toner 
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l Open the rear door and try printing to the rear outpu

l Turn over the stack of paper in the tray or try rotatin
180° in the input tray.

Hint If the page is totally blank (all white) check to make sure
tape is removed from the toner cartridge and ensure tha
cartridge is installed correctly.
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Infrared Printing Problems

omputer you 
-compliant; 
symbol on the 
 the 

ual. 

perating 
omputer 
river and your 
ing an HP 
eries printer 
ind that 

take longer to 

ply the IR 
mputer port. 
available 
ware or 
 
ontact your 

tware tech 
n a driver.

ave 
evice within 
ration and that 
 as a finger, 
 bright light 
ith the 
 make sure 

 are clean 
d grease).
EN Chapter 4 Proble

Infrared Printing Problems

Symptom Possible Cause Solution

The connection cannot be 
established or the 
transmission seems to be 
taking longer than usual.

Computer is not IrDA-
compliant.

Make sure the c
are using is IrDA
look for an IrDA 
device or refer to
computer’s man

IR Driver is not installed on 
your computer or Personal 
Digital Assistant (PDA).

Make sure the o
system on the c
includes an IR d
application is us
LaserJet 2100 s
driver. Keep in m
complex pages 
print.

HP does not sup
driver for the co
The IR driver is 
through the hard
operating system
manufacturers. C
hardware or sof
support to obtai

Computer and printer are not 
positioned properly.

Make sure you h
positioned the d
the range of ope
no objects, such
paper, books, or
are interfering w
connection. Also
the two IR ports
(free from dirt an
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o bright light 
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, or light from 
te control, 

sed for TVs 
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sition the 
 the IR port on 

evices are 
ver from 
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 is broken 
job has 
ter may not 
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n the device 
 of operation 
 again.

le) light is on, 
EL to clear the 
 Position the 
 range of 

rint the job 

Infrared Printing Problems (continued)

Symptom Possible Cause Solution
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The connection cannot be 
established or the 
transmission seems to be 
taking longer than usual 
(continued).

Bright lights are interfering 
with the signal.

Make sure that n
is shining directl
port. Bright light
(sunlight, incand
fluorescent light
an infrared remo
such as those u
and VCRs) shini
one of the IR po
interference. Po
device closer to
the printer.

The printer prints only part of a 
page or document.

The connection has been 
interrupted during 
transmission.

IrDA-compliant d
designed to reco
temporary conn
interruptions. Re
connection. (De
device you are u
take anywhere f
seconds to re-es
connection.)

The print job has been 
properly sent to the printer, but 
the printer will not print.

The connection may have 
been disrupted or broken.

If the connection
before the print 
started, the prin
print any of the j
(middle) light is 
CANCEL to clear
memory. Positio
within the range
and print the job

The IR status light turns off 
during transmission.

The connection may have 
been broken.

If the Data (midd
press JOB CANC

printer memory.
device within the
operation and p
again.
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Troubleshooting Error Messages 

When the printer experiences an error, the control panel will indicate 
the error message by five light patterns. Find the light pattern below 

mendations 
al a 
rror is 

.

.

he trays with 
e with the 

Accessory
 Error
EN Chapter 4 Proble

that matches the printer light pattern and follow the recom
to troubleshoot the error. Some error messages will sign
secondary light message that will indicate what type of e
occurring. See “Secondary Light Patterns” on page 102

Note Common status light patterns are described on page 16

Paper Out

The printer is out of paper in the requested tray. Filling t
paper will cancel this message and allow you to continu
print job.

Continuable
Error

Attention Service
Error

OnOff Blinking

Paper Out
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Attention

There are three possible causes that will display the Attention light 
pattern:

ssing the GO 
e cause of 

to clear the 
lay the 

 and the 
till in the 

t the current 
ttempt to 
he attempt to 
 blink while 
er, it will 

 and the 
een fixed.

ly and then 
econdary 
ng to the 
 102.
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l Door open

l Toner cartridge missing

l Paper jam

After the cause of the problem has been addressed, pre
button will cause the printer to attempt to recover from th
the error. If there is a paper jam, the printer will attempt 
jam. If the printer is unsuccessful, it will continue to disp
Attention message until the cause is remedied.

Pressing the JOB CANCEL button will cancel the print job
printer will return to Ready unless there is a paper jam s
printer. See “Clearing Paper Jams” on page 85.

Continuable Error

An error has occurred that has caused the printer to hal
print job. Pressing the GO button causes the printer to a
recover from the error and print whatever data it can. If t
recover from the error is successful, the Ready light will
the printer completes the job. If the printer cannot recov
display the Continuable Error message.

Pressing the JOB CANCEL button will cancel the print job
printer will return to ready if the cause of the error has b

Pressing the GO and JOB CANCEL buttons simultaneous
releasing the buttons will cause the printer to display a s
light pattern that will indicate the error code correspondi
current error condition. See “Continuable Error” on page
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Service Error

An error has occurred that has caused the printer to halt the current 
print job. Pressing the GO button or the JOB CANCEL button with this 

f the problem 
formatter. If 

r the EIO port 
 current print 
ith this 

ly and then 
econdary 
ng to the 
05.
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message has no effect.

To clear the error, turn the printer off and then on again. I
persists, leave the printer off for 15 minutes to reset the 
the problem continues, contact HP Service.

Accessory Error

An error has occurred with one of the accessories, eithe
or the DIMM slots, that has caused the printer to halt the
job. Pressing the GO button or the JOB CANCEL button w
message has no effect.

Pressing the GO and JOB CANCEL buttons simultaneous
releasing the buttons will cause the printer to display a s
light pattern that will indicate the error code correspondi
current error condition. See “Accessory Error” on page 1
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Secondary Light Patterns

ll.
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me printer 
y unnecessary 
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Continuable Error

Type of Error Light Pattern Recommended Action

Memory Overflow The printer memory is fu
Press Go to resume prin
some data, try to free so
memory by removing an
fonts, macros, or any dat
printer memory. If you co
data, you may need to a
memory. For a temporar
simplify the image or prin
resolution.

Temporary Engine 
Error

The printer has experien
engine error. Reset the p
turning the printer off and

Print Overrun The print job was too com
available printer memory
Press Go to resume prin
some data, you may nee
printer memory. For a tem
solution, simplify the ima
600-dpi resolution.
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rinter and 
nection or the 
heck the cable 

y are secure. 
 a high-quality 

ced a temporary 
y briefly turning 
n again.

 (NVRAM) is 

ssage. Check 
sure they are 
rsists, contact 

e representative.

Continuable Error (continued)

Type of Error Light Pattern Recommended Action
EN Chapter 4 Problem

IO Error The cable between the p
computer has a bad con
cable is of poor quality. C
connections to see if the
Make sure you are using
cable.

Temporary Error The printer has experien
error. Reset the printer b
the printer off and back o

NVRAM Error The nonvolatile memory
temporarily full.
Press Go to clear the me
the printer settings to en
correct. If the problem pe
your dealer or HP servic
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ced a temporary 
ter by turning 
n again.

Continuable Error (continued)

Type of Error Light Pattern Recommended Action
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EIO Error The printer has experien
EIO error. Reset the prin
the printer off and back o
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Accessory Error

Type of Error Light Pattern Recommended Action

sory from the 
lot indicated by 

e printing.

sory from the 
lot indicated by 

e printing.

sory from the 
lot indicated by 

e printing.
EN Chapter 4 Problem

EIO Port Error Remove the acces
EIO Port or DIMM S
the error to continu

DIMM Slot 1 Error Remove the acces
EIO Port or DIMM S
the error to continu

DIMM Slot 2 Error Remove the acces
EIO Port or DIMM S
the error to continu
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sory from the 
lot indicated by 

e printing.

Accessory Error (continued)

Type of Error Light Pattern Recommended Action
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DIMM Slot 3 Error Remove the acces
EIO Port or DIMM S
the error to continu
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Network Problems 

You are experiencing shared printer problems.

rint server is 
t a second 

it directly to a 
m an 
is works, 
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l Print a Configuration page. If an HP JetDirect EIO p
installed, printing a Configuration page will also prin
page that will show the network settings and status.

l Try printing the job from another computer.

l To verify if a printer works with a computer, connect 
computer with a parallel cable. Print a document fro
application that has printed correctly in the past. If th
then there may be a problem with the network.

l Contact your network administrator for assistance.
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Common Windows Problems

ve all software 
, then restart 

 printer drivers.

re connected 
n, and the 
.

nication is not 
it will also 

, Printers. 
aserJet 2100 
rties. Click on 
emove check 

 before 
 Click on 
Print Directly 

ions, reboot 
.

r. If the 
es PCL 6 
h to another 
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iver or a 
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Common Windows Problems

Symptom Possible Cause Solution

Windows message during 
installation reads: “File in 
Use.”

Quit all software. Remo
from the StartUp Group
Windows. Reinstall the

Error Message:
“Error Writing to LPTx” in 
Windows 9x. 

Make sure the cables a
correctly, the printer is o
Ready (front) light is on

If bi-directional commu
turned on in the driver, 
cause this message.

Click on Start, Settings
Right click on the HP L
driver and select Prope
Details, Port Settings. R
from “Check Port State
Printing” box. Click OK.
Spool Settings. Select “
to Printer.” Click OK. 
Try printing again.

Error Message:
“General Protection Fault”
“Exception OE”
“Spool32”
“Illegal Operation”

Close all other applicat
Windows, and try again

Switch the printer drive
HP LaserJet 2100 Seri
Driver is selected, switc
printer driver such as a
2100 Series PCL 5e Dr
Microsoft Driver.
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m the Temp 
determine the 
y editing the 
d looking for 
p = .” The 

nt is the temp 
:\temp  by 
fined.

ows 3.x, 9x, or 
that came with 
rmation on 
es.

Common Windows Problems (continued)

Symptom Possible Cause Solution
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Error Message:
“General Protection Fault”
“Exception OE”
“Spool32”
“Illegal Operation”
(Continued)

Delete all temp files fro
sub-directory. You can 
name of the directory b
AUTOEXEC.BAT file an
the statement “Set Tem
name after this stateme
directory. It is usually C
default, but can be rede

Refer to Microsoft Wind
NT 4.0 documentation 
your PC for further info
Windows error messag
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Common Macintosh Problems 

should be 
 Mac OS. 
erWriter driver 
er within the 
stall the 

ponent from 

g a high-

 on the correct 
twork or 
l from Control 
nu and then 
ork.

re connected 
n, and the 
.

rinter driver 
e Chooser.

a network with 
ure the correct 
“AppleTalk 
ser.
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Macintosh Problems

Symptom Possible Cause Solution

Problems in the Chooser

Printer driver icon does not 
appear in the Chooser.

Software not installed 
correctly.

The LaserWriter driver 
present as a part of the
Make sure that the Las
is in the Extensions fold
systems folder. If not, in
LaserWriter driver com
the installation CD.

Make sure you are usin
quality cable.

Make sure the printer is
network. Select the Ne
AppleTalk Control Pane
Panels in the Apple me
choose the correct netw

Printer name does not 
appear in the “Select a 
PostScript Printer” box in 
the Chooser.

Make sure the cables a
correctly, the printer is o
Ready (front) light is on

Make sure the correct p
has been selected in th

If the printer resides on 
multiple zones, make s
zone is selected in the 
Zones” box in the Choo



 Solving  111

as been 
by printing a 
ly press GO 
k the 

printer 
st page.

 on. (The 
selected in the 
d to restart the 
e change.

tware. See 
 on page 10.

. 

ng the 
king sure that 
 names. 

ng on in the 
ges will now 
nt Monitor 
e working 
ocessing data 
.

her

ng on by 
ktop, and 

Macintosh Problems (continued)

Symptom Possible Cause Solution
EN Chapter 4 Problem

Make sure the printer h
chosen in the Chooser 
self-test. (Simultaneous
and JOB CANCEL.) Chec
AppleTalk name of the 
displayed on the self-te

Make sure AppleTalk is
button next to Active is 
Chooser.) You may nee
computer to activate th

The printer driver does not 
automatically set up your 
selected printer even 
though you clicked Auto 
Setup in the Chooser.

Reinstall the printer sof
“Macintosh Installation”

Select an alternate PPD

Printing Errors 

A print job was not sent to 
your desired printer.

Another printer with the 
same or similar name 
may have received your 
print job. 

Rename the printer usi
HP LaserJet Utility, ma
all devices have unique

You cannot use the 
computer while the printer 
is printing.

Background Printing has 
not been selected.

LaserWriter 8.3

Turn Background Printi
Chooser. Status messa
be redirected to the Pri
allowing you to continu
while the computer is pr
to be sent to the printer

LaserWriter 8.4 and hig

Turn Background Printi
selecting File, Print Des
Background Printing.
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Macintosh Problems (continued)

Symptom Possible Cause Solution
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An encapsulated 
PostScript (EPS) file does 
not print with the correct 
fonts. 

This problem occurs with 
some software 
applications. 

Try downloading the fon
in the EPS file to the pr
printing.

Your document is not 
printing with New York, 
Geneva, or Monaco. 

Select Options in the P
dialog box to deselect s
fonts.
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Selecting an Alternate PPD
1. Open the Chooser from the Apple menu. 

2. Click the LaserWriter icon.

e zone in the 

 a PostScript 
te the next 

time setup.)

e desired 
s:

The generic 
 printer 

OK to return 

next to the 
 the Chooser, 
o bring up the 

ecting the 
lecting it in 
nd reselect it.

lity to rename 
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3. If you are on a network with multiple zones, select th
AppleTalk Zones box where the printer is located.

4. Click the printer name you want to use in the Select
Printer box. (Double-clicking will immediately genera
few steps.)

5. Click Setup... (This button may read Create for first-

6. Click Select PPD....

7. Find the desired PPD in the list and click Select. If th
PPD is not listed, choose one of the following option

• Select a PPD for a printer with similar features.

• Select a PPD from another folder.

• Select the generic PPD by clicking Use Generic. 
PPD allows you to print, but limits your access to
features.

8. In the Setup dialog box, click Select, and then click 
to the Chooser.

Note If you manually select a PPD, an icon might not appear 
selected printer in the Select a PostScript Printer box. In
click Setup, click Printer Info, and then click Update Info t
icon.

9. Close the Chooser.

Renaming the Printer

If you are going to rename the printer, do this before sel
printer in the Chooser. If you rename the printer after se
the Chooser, you will have to go back into the Chooser a

Use the Set Printer Name feature in the HP LaserJet Uti
the printer. 
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Troubleshooting PS Errors 

The following situations are PS language specific and may occur 
when several printer languages are being used.

 PS errors 
ired selection 

sired font and 
b again. Verify 
ation of the 
to printer if 
k with the 

entation.

 print your job 
inch, reduce 
f the page, or 
ory. 

rint job is a PS 
e whether the 
tion expected 
ader file to be 
r.

 print your job 
inch, reduce 
f the page, or 
ory. 
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Note To receive a printed or screen displayed message when
occur, open the Print Options dialog box and click the des
next to the PS Errors section.

PS Errors

Symptom Possible Cause Solution

The job prints in Courier (the 
printer’s default typeface) 
instead of the typeface you 
requested.

The requested typeface is not 
downloaded. A personality 
switch may have been 
performed to print a PCL job 
just before the PS printing job 
was received.

Download the de
send the print jo
the type and loc
font. Download 
applicable. Chec
software docum

A legal page prints with 
clipped margins. 

Print job too complex. You may need to
at 600 dots per 
the complexity o
install more mem

A PS error page prints. Print job may not be PS. Make sure the p
job. Check to se
software applica
a setup or PS he
sent to the printe

Specific Errors

Limit Check Error Print job too complex. You may need to
at 600 dots per 
the complexity o
install more mem
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nts from 

 
nts from 

PS Errors (continued)

Symptom Possible Cause Solution
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VM Error Font Error Select unlimited
downloadable fo
printer driver.

Range Check Font Error Select unlimited
downloadable fo
printer driver.
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5 Service and Support
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Availability

HP provides a variety of service and support options aro
world. Availability of these programs will vary depending
location.

HP Express Exchange

1. The customer contacts the local HP Customer Supp
listed in the product documentation. A technician tro
the situation and determines whether the printer has
failed. If so, the technician refers the customer to the
Center. 

2. A representative from the service center requests p
customer information. In some regions, collateral m
requested. 

3. HP ships a refurbished replacement unit to arrive th
(Geographic distance might prevent next-day shippi

4. The customer sends the defective printer to Hewlett
HP's expense. 

Customers with on-site support service provided by HP 
directly with the local Customer Support Center instead
the steps outlined here.

Exchanged units carry the remainder of the original unit
90 days, whichever is greater. The faster turnaround from
Exchange minimizes downtime over traditional service p
require you to ship the failed unit to the manufacturer, an
for it to be repaired and returned. Because HP pays the
charges, you incur no hidden costs for the service.
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Guidelines for Repacking the Printer

l Remove and retain any DIMMs (dual in-line memory modules) 
installed in the printer.

ries installed 

MMs, either 
face of the 
 printer. To 
.

ridge in its 
sed to light.

terial, if 
te packing is 
posed of the 

rvice for 

 of paper or 

 Form on 

nt.
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l Remove and retain any cables and optional accesso
in the printer.

CAUTION Static electricity can damage DIMMs. When handling DI
wear an antistatic wrist strap or frequently touch the sur
DIMMs’ antistatic package, then touch bare metal on the
remove the DIMMs see “Installing Memory” on page 153

l Remove and retain the toner cartridge.

CAUTION To prevent damage to the toner cartridge, store the cart
original packing material, or store it so that it is not expo

l Use the original shipping container and packing ma
possible. (Shipping damage as a result of inadequa
the customer’s responsibility.) If you have already dis
printer’s packing material, contact a local mailing se
information on repacking the printer. 

l If possible, include print samples and 50-100 sheets
other media that did not print correctly.

l Include a completed copy of the Service Information
page 119.

l HP recommends insuring the equipment for shipme
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Service Information Form

WHO IS RETURNING THE EQUIPMENT? Date:

leaning supplies, 

)

oing when the 
)

number.)

__________
al received date.)

orized 
 do not apply, 
by contacting 

__________
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Person to contact: Phone: (     )

Alternate contact: Phone: (     )

Return shipping address: Special shipping instructions:

WHAT IS BEING SENT?

Model name: Model number: Serial number:

Please attach any relevant printouts when returning equipment. DO NOT ship accessories (manuals, c
etc.) that are not required to complete the repair.

WHAT NEEDS TO BE DONE?   (Attach a separate sheet if necessary.

1. Describe the conditions of the failure. (What was the failure? What were you d
failure occurred? What software were you running? Is the failure repeatable?

2. If the failure is intermittent, how much time elapses between failures?

3. Is the unit connected to any of the following? (Give manufacturer and model 

Personal computer: Modem: Network:

4. Additional comments:

HOW WILL YOU PAY FOR THE REPAIR?

o Under warranty Purchase/received date: __________________
(Enclose proof of purchase or receiving document with origin

o Maintenance contract number: ______________________

o Purchase order number: ___________________________

Except for contract and warranty service, a purchase order number and/or auth
signature must accompany any request for service.  If standard repair prices
a minimum purchase order is required. Standard repair prices can be obtained 
an HP-authorized Repair Center.

Authorized signature: ______________________________ Phone: ______

Billing address: Special billing instructions:
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HP Maintenance Agreements

HP has several types of maintenance agreements that meet a wide 
range of support needs. Maintenance agreements are not part of the 

k with your 
u.

ur needs, HP 
es:

r site for calls 

y following a 
d travel 
 most on-site 

s for 
s designated 
g printers, 
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standard warranty. Support services vary by area. Chec
local HP dealer to determine the services available to yo

On-Site Service Agreements
To provide you with the level of support best suited to yo
has on-site service agreements with three response tim

Priority On-Site Service

This agreement provides 4-hour service response to you
made during normal HP business hours.

Next-Day On-Site Service

This agreement provides support by the next working da
service request. Extended coverage hours and extende
beyond HP’s designated service zones are available on
agreements (for additional charges).

Weekly (Volume) On-Site Service

This agreement provides scheduled weekly on-site visit
organizations with many HP products. This agreement i
for sites using 25 or more workstation products, includin
plotters, computers, and disk drives.
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Hewlett-Packard Limited Warranty Statement
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HP PRODUCT DURATION OF WARRANTY

HP LaserJet 2100, 2100 M, 2100 TN 1 year, Return to Authorized 
EN Chapter 5 Service and

1. HP warrants to you, the end-user customer, that HP hardware, acce
supplies, will be free from defects in materials and workmanship afte
purchase, for the period specified above. If HP receives notice of su
during the warranty period, HP will, at its option, either repair or repl
which prove to be defective. Replacement products may be either ne

2. HP warrants to you that HP software will not fail to execute its progra
instructions after the date of purchase, for the period specified above
defects in material and workmanship when properly installed and us
receives notice of such defects during the warranty period, HP will re
software media which does not execute its programming instructions
defects.

3. HP does not warrant that the operation of HP products will be uninte
error free. If HP is unable, within a reasonable time, to repair or repla
product to a condition as warranted, you will be entitled to a refund o
purchase price upon prompt return of the product.

4. HP products may contain remanufactured parts equivalent to a new 
performance or may have been subject to incidental use.

5. Warranty does not apply to defects resulting from (a) improper or ina
maintenance or calibration, (b) software, interfacing, parts or supplies
by HP, (c) unauthorized modification or misuse, (d) operation outside
published environmental specifications for the product, or (e) improp
preparation or maintenance.

6. HP MAKES NO OTHER EXPRESS WARRANTY OR CONDITION W
WRITTEN OR ORAL. TO THE EXTENT ALLOWED BY LOCAL LAW
IMPLIED WARRANTY OR CONDITION OR MERCHANTABILITY, 
SATISFACTORY QUALITY, OR FITNESS FOR A PARTICULAR PUR
LIMITED TO THE DURATION OF THE EXPRESS WARRANTY SET
ABOVE. Some countries, states or provinces do not allow limitations
duration of an implied warranty, so the above limitation or exclusion 
apply to you. This warranty gives you specific legal rights and you mi
other rights that vary from country to country, state to state, or provin
province.

Service Center
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7. TO THE EXTENT ALLOWED BY LOCAL LAW, THE REMEDIES IN THIS 
WARRANTY STATEMENT ARE YOUR SOLE AND EXCLUSIVE REMEDIES. 
EXCEPT AS INDICATED ABOVE, IN NO EVENT WILL HP OR ITS SUPPLIERS 
BE LIABLE FOR LOSS OF DATA OR FOR DIRECT, SPECIAL, INCIDENTAL, 
CONSEQUENTIAL (INCLUDING LOST PROFIT OR DATA), OR OTHER 
DAMAGE, WHETHER BASED IN CONTRACT, TORT, OR OTHERWISE. Some 

 of incidental 
 not apply to 

ALAND; THE 
 TO THE 
 OR MODIFY 
TS 
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countries, states or provinces do not allow the exclusion or limitation
or consequential damages, so the above limitation or exclusion may
you.

8. FOR CONSUMER TRANSACTIONS IN AUSTRALIA AND NEW ZE
WARRANTY TERMS CONTAINED IN THIS STATEMENT, EXCEPT
EXTENT LAWFULLY PERMITTED, DO NOT EXCLUDE, RESTRICT
AND ARE IN ADDITION TO THE MANDATORY STATUTORY RIGH
APPLICABLE TO THE SALE OF THIS PRODUCT TO YOU.
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Limited Warranty for Toner Cartridge Life

Note The warranty below applies to the toner cartridge that came with this 

s in materials 
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printer. 

HP toner cartridges are warranted to be free from defect
and workmanship until the HP toner is depleted. The wa
any defects or malfunctions in a new Hewlett-Packard to

How long does the coverage last?
The coverage lasts until the HP toner is depleted, at which tim
expires.
How do I know when the HP toner is running out?
The HP toner is depleted when faded or light type appears on
page.
What will HP do?
HP will, at HP’s option, either replace products which prove to 
refund the purchase price. If possible, please attach a printout
illustrating what the defective cartridge is printing.
What does this warranty not cover?
The warranty does not cover cartridges which have been refill
emptied, are abused, are misused, or are tampered with in an
How do I return the faulty cartridge?
In the event the cartridge proves to be defective, complete the
Information Form and attach a print sample illustrating the def
form and cartridge to the place of purchase, where the cartridg
replaced.
How does State, Province or Country Law apply?
This limited warranty gives you specific legal rights, and you m
other rights which vary from state to state, province to province
country. This limited warranty is the sole warranty on the HP to
and supersedes any other warranty relating to this product.

FOR CONSUMER TRANSACTIONS IN AUSTRALIA AND NE
THE WARRANTY TERMS CONTAINED IN THIS STATEMENT
THE EXTENT LAWFULLY PERMITTED, DO NOT EXCLUDE,
OR MODIFY AND ARE IN ADDITION TO THE MANDATORY 
RIGHTS APPLICABLE TO THE SALE OF THIS PRODUCT T

IN NO EVENT SHALL HEWLETT-PACKARD COMPANY BE L
ANY INCIDENTAL, CONSEQUENTIAL, SPECIAL, INDIRECT
OR EXEMPLARY DAMAGES OR LOST PROFITS FROM ANY
THIS WARRANTY OR OTHERWISE.



EN

Worldwide Sales and Service Offices

Note Before calling an HP Sales and Service office, be sure to contact the 
he 
 these offices. 
appropriate 
f this guide.
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appropriate Customer Support Center number listed in t
“HP Support” section. Products should not be returned to
Product return information is also available through the 
Customer Support Center in “HP Support” in the front o

Argentina
Hewlett-Packard Argentina S.A.
Montañeses 2140/50/60
1428 Buenos Aires
Phone: (54) (1) 787-7100
Fax: (54) (1) 787-7213

Australia
Hewlett-Packard Australia Ltd.
31-41 Joseph Street
Blackburn, VIC 3130
Phone: (61) (3) 272-2895
Fax: (61) (3) 898-7831
Hardware Repair Center:
Phone: (61) (3) 272-8000
Extended Warranty Support:
Phone: (61) (3) 272-2577
Customer Information Center:
Phone: (61) (3) 272-8000

Austria
Hewlett-Packard GmbH
Lieblgasse 1
A-1222 Vienna
Phone: (43) (1) 25000-555
Fax: (43) (1) 25000-500

Belgium
Hewlett-Packard Belgium S.A. NV
Boulevard de la Woluwe-Woluwedal 
100-102
B-1200 Brussels
Phone: (32) (2) 778-31-11
Fax: (32) (2) 763-06-13

Brazil
Edisa Hewlett-Packard SA
Alameda Rio Negro 750
06454-050 Alphaville - Ba
Phone:  (55) (11)- 7296-8

Canada
Hewlett-Packard (Canada
17500 Trans Canada High
South Service Road
Kirkland, Québec H9J 2X8
Phone: (1) (514) 697-4232
Fax: (1) (514) 697-6941

Hewlett-Packard (Canada)
5150 Spectrum Way
Mississauga, Ontario L4W
Phone: (1) (905) 206-4725
Fax: (1) (905) 206-4739

Chile
Hewlett-Packard de Chile
Avenida Andres Bello 277
Los Condes
Santiago, Chile

China
China Hewlett-Packard Co
Level 5, West Wing Office
China World Trade Center
No. 1, Jian Guo Men Wai A
Beijing 100004
Phone: (86) (10) 6505-38
Fax: (86) (10) 6505-103
Hardware Repair Center a
Warranty Support:
Phone: (86) (10) 6262-56

(86) (10) 6261-41
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Colombia
Hewlett-Packard Colombia
Calle 100 No. 8A -55
Torre C Oficina 309
Bogotá, Colombia

Germany
Hewlett-Packard GmbH
Herrenberger Straße 130
71034 Böblingen
Phone: (49) (180) 532-6222

43
22

szág Kft.
 

ter:

nd Extended 

pA
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Czech Republic
Hewlett-Packard s. r. o.
Novodvorská 82
CZ-14200 Praha 4
Phone: (42) (2) 613-07111
Fax: (42) (2) 471-7611

Denmark
Hewlett-Packard A/S
Kongevejen 25
DK-3460 Birkerød
Denmark
Phone: (45)3929 4099
Fax: (45) 4281-5810

Far East Region
Hewlett-Packard Asia Pacific Ltd.
17-21/F Shell Tower, Times Square
1 Matheson Street, Causeway Bay
Hong Kong 
Phone: (852) 2599-7777
Fax: (852) 2506-9261
Hardware Repair Center:
Phone: (852) 2599-7000
Extended Warranty Support:
Phone: (852) 2599-7000
Customer Information Center:
Phone: (852) 2599-7066

Finland
Hewlett-Packard Oy
Piispankalliontie 17
FIN-02200 Espoo
Phone: (358) (9) 887-21
Fax: (358) (9) 887-2477

France
Hewlett-Packard France
42 Quai du Point du Jour
F-92659 Boulogne Cedex
Phone: (33) (146) 10-1700
Fax: (33) (146) 10-1705

(49) (180) 525-81
Fax: (49) (180) 531-61

Greece
Hewlett-Packard Hellas
62, Kifissias Avenue
GR-15125 Maroussi
Phone: (30) (1) 689-6411
Fax: (30) (1) 689-6508

Hungary
Hewlett-Packard Magyaror
Erzsébet királyné útja 1/c.
H-1146 Budapest
Phone: (36) (1) 343-0550
Fax: (36) (1) 122-3692
Hardware Repair Center:
Phone: (36) (1) 343-0312
Customer Information Cen
Phone: (36) (1) 343-0310

India
Hewlett-Packard India Ltd.
Paharpur Business Centre
21 Nehru Place
New Delhi 110 019
Phone: (91) (11) 647-2311
Fax: (91) (11) 646-1117
Hardware Repair Center a
Warranty Support:
Phone: (91) (11) 642-5073

(91) (11) 682-6042

Italy
Hewlett-Packard Italiana S
Via Giuseppe di Vittorio, 9
Cernusco Sul Naviglio
I-20063 (Milano)
Phone: (39) (2) 921-21
Fax: (39) (2) 921-0447
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Japan
Hewlett-Packard Japan, Ltd.
3-29-21 Takaido-higashi 
Suginami-ku, Tokyo 168 
Phone: (81) (3) 3335-8333

Netherlands
Hewlett-Packard Nederland 
BV Startbaan 16
NL-1187 XR Amstelveen
Postbox 667

-51
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Fax: (81) (3) 3335-8338
Hardware Repair Center:
Phone: (81) (4) 7355-6660
Fax: (81) (4) 7352-1848

Korea
Hewlett-Packard Korea
25-12, 
Yoido-dong, Youngdeungpo-ku
Seoul 150-010
Phone: (82) (2) 769-0114
Fax: (82) (2) 784-7084
Hardware Repair Center: 
Phone: (82) (2) 3270-0700

(82) (2) 707-2174 (DeskJet)

(82) (2) 3270-0710 (Hardware)

Extended Warranty Support:
Phone: (82) (2) 3770-0365 (Bench)

(82) (2) 769-0500 (Onsite)

Latin American
Headquarters
5200 Blue Lagoon Drive Suite 950
Miami, FL 33126,USA
Phone: (1) (305) 267-4220

México
Hewlett-Packard de México, S.A. de C.V.
Prolongación Reforma No. 700
Lomas de Santa Fe
01210 México, D.F.
Phone: 01-800-22147 
Outside Mexico City
Phone: 01 800-90529

Middle East/Africa
ISB HP Response Center
Hewlett-Packard S.A.
Rue de Veyrot 39
P.O. Box 364
CH-1217 Meyrin - Geneva
Switzerland
Phone: (41) (22) 780-4111

NL-1180 AR Amstelveen
Phone: (31) (020) 606-87
Fax: (31) (020) 547-77

New Zealand
Hewlett-Packard (NZ) Lim
Ports of Auckland Building
Princes Wharf, Quay Stree
P.O. Box 3860
Auckland
Phone: (64) (9) 356-6640
Fax: (64) (9) 356-6620
Hardware Repair Center a
Warranty Support:
Phone: (64) (9) 0800-733
Customer Information Cen
Phone: (64) (9) 0800-651

Norway
Hewlett-Packard Norge A/
Postboks 60 Skøyen
Drammensveien 169
N-0212 Oslo
Phone: (47) 2273-5600
Fax: (47) 2273-5610

Poland
Hewlett-Packard Polska
Al. Jerozolimskic 181
02-222 Warszawa
Phone: (48-22) 608-7700
Fax: (48-22) 608-7600

Russia
AO Hewlett-Packard
Business Complex Buildin
129223, Moskva, Prospek
Phone: (7) (95) 928-6885
Fax: (7) (95) 974-7829
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Singapore
Hewlett-Packard Singapore
(Sales) Pte Ltd
450 Alexandra Road
Singapore (119960)

Thailand
Hewlett-Packard (Thailand) Ltd.
23-25/f Vibulthani Tower II
2199 Rama 4 Rd, Klongton
Klintoey, Bangkok 10110

-34
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Phone:  (65)275-3888
Fax:  (65)275-6839Hardware Repair 
Center and Customer
Information Center:
Phone: (65) 272-5300
Extended Warranty Support:
Phone: (65) 272-5333

Spain
Hewlett-Packard Española, S.A.
Carretera de la Coruña km 16.500
E-28230 Las Rozas, Madrid
Phone: (34) (1) 626-1600
Fax: (34) (1) 626-1830

Sweden
Hewlett-Packard Sverige AB
Skalholtsgatan 9
S-164 97 Kista
Phone: (46) (8) 444-2000
Fax: (46) (8) 444-2666

Switzerland
Hewlett-Packard (Schweiz) AG
In der Luberzen 29
CH-8902 Urdorf/Zürich
Phone: (41) (084) 880-11-11
Fax: (41) (1) 753-7700
Warranty Support:
0800-55-5353

Taiwan
Hewlett-Packard Taiwan Ltd.
8th Floor
337, Fu-Hsing North Road
Taipei, 10483
Phone: (886)(02)717-0055
FAX : (886)(02)514-0276
Hardware Repair Center, call:
North (886)(02) 717-9673 
Central (886)(04) 327-0153 
South (886)(080)733-733 
Extended Warranty Support Contact:
Phone:  (886)(02) 714-8882

Thailand
Phone: (66) (2) 666-3900
Fax: (66) (2) 666-3935
Hardware Repair Center a
Warranty Support Contact
Phone: (66) (2) 661-3900
Customer Information Cen
Phone: (66) (2) 661-3900
Fax: (66) (2) 661-3943

Turkey
Hewlett-Packard Company
Bilgisayar Ve ölçüm Sistem
19 Mayis Caddesi Nova
Baran Plaza Kat: 12
80220 Sisli-Istanbul
Phone: (90) (212) 224-592
Fax: (90) (212) 224-59

United Kingdom
Hewlett-Packard Ltd.
Cain Road
Bracknell
Berkshire RG12 1HN
Phone: (44) (134) 436-92
Fax: (44) (134) 436-33

Venezuela
Hewlett-Packard de Venez
Los Ruices Norte
3A Transversal
Edificio Segre Caracas 10
Phone: (58) (2) 239-4244

Fax: (58) (2) 239-3080
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Printer Specifications

HP LaserJet 2100
HP LaserJet 2
Optional Tray 3

Height 230 mm (9 in.) 309 mm (12.2 in

Width 406 mm (15.9 in.) 406 mm (15.9 in

Depth (body) 420 mm (16.5 in.) 420 mm (16.5 in

Weight (with toner cartridge) 11.5 kg (25.4 lbs) 14.4 kg (31.7 lbs

Electrical Specifications
100-127V (+/- 10%) 
50/60Hz (+/- 2Hz)

220-240V (+/- 
50/60 Hz (+/- 2

Power Consumption (typical 
for HP LaserJet 2100 Series 
Printers)

During printing  225 W 
(average)
During standby 12 W (instant 
power save)
During power save mode 12 W
During off mode 0W

During printing 2
(average)
During standby 
power save)
During power sa
During off mode

Minimum recommended circuit 
capacity

5 Amps 2.5 Amps 
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WARNING! Power requirements are based on the region where the printer is sold. 
Do not convert operating voltages. This may damage the printer and 
void the product warranty. 

er

 bels(A)
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Environmental 
Specifications Operating Printing Storage/Standby

Temperature
(printer and toner cartridge) 

15° to 32.5° C
(59° to 89° F)

-20° to 40° C
(-4° to 104° F)

Relative humidity 10% to 80% 10% to 90% 

Acoustic 
Emissions 
(Per ISO 9296)
(HP LaserJet 2100 
at 10 ppm) Operator Position Bystander (1m) Sound Pow

Printing LpAm 55dB(A) LpAm 48dB(A) LWAd 6.2

Power Save
In this mode, the printer is essentially quiet.

See “Printer Features” on page 2 for additional performance and features specifications
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FCC Regulations

This equipment has been tested and found to comply with the limits 
for a Class B digital device, pursuant to Part 15 of the FCC rules. 
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These limits are designed to provide reasonable protect
harmful interference in a residential installation. This eq
generates, uses, and can radiate radio frequency energ
equipment is not installed and used in accordance with 
instructions, it may cause harmful interference to radio 
communications. However, there is no guarantee that int
not occur in a particular installation; the presence of inte
be determined by turning the equipment off and on. If th
does cause harmful interference to radio or television 
communications, the user is encouraged to try to correc
interference by one or more of the following measures:

l Reorient or relocate the receiving antenna.

l Increase distance between equipment and receiver.

l Connect equipment to an outlet on a circuit different
which the receiver is located.

l Consult your dealer or an experienced radio/televisi

Note Any changes or modifications to the printer that are not 
approved by HP could void the user’s authority to opera
equipment.

Use of a shielded interface cable is required to comply w
B limits of Part 15 of FCC rules.
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Environmental Product Stewardship Program
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Hewlett-Packard Company is committed to providing qu
in an environmentally sound manner. This HP LaserJet 
been designed with several attributes to minimize impac
environment.

This HP LaserJet printer eliminates:

Ozone Production

The printer uses charging rollers in the electrophotograp
and therefore generates no appreciable ozone gas (O3)

This HP LaserJet printer design reduces:

Energy Consumption

Energy usage drops to as little as 12 W while in low-pow
(PowerSave) mode. Not only does this save natural reso
also saves money without affecting the high performanc
printer. This product qualifies for ENERGY STAR. ENERGY

voluntary program established to encourage the develop
energy-efficient office products. ENERGY STAR is a U.S. r
service mark of the U.S. EPA.

As an ENERGY STAR partner, Hewlett-Packard Company
determined that this product meets ENERGY STAR Guide
energy efficiency.

Toner Consumption

EconoMode uses significantly less toner, which may ext
the toner cartridge.

Paper use

You can request for a number of pages of your documen
printed on one page of paper. This N-up printing practic
printer’s manual duplexing feature, two-sided printing, ca
paper usage and the resulting demands on natural reso
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The design of this HP LaserJet printer facilitates the 
recycling of:

Plastics

Plastic parts have markings according to international standards that 
oses at the 
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enhance the ability to identify plastics for recycling purp
end of the printer’s life.

HP Toner Cartridges

In many countries, this product’s toner cartridge/drum ca
returned to HP through the HP Planet Partners LaserJe
Cartridge Recycling Program. This easy to use program
in over 20 countries. Multi-lingual program information a
instructions are included in every new HP Toner Cartrid

HP Planet Partners LaserJet Toner Cartridge Recycling 
Information: Since 1990, the HP LaserJet Toner Cartrid
Program has collected more than 12 million used toner c
otherwise may have been discarded in the world’s landf
LaserJet toner cartridges go to a collection center and t
bulk shipped to our recycling partners who disassemble
parts for recycling. After a thorough quality inspection, m
such as nuts, screws, and clips are reclaimed for use in
cartridges. Remaining materials are separated and conv
raw materials for use by other industries to make a varie
products. Over 95% by weight of each returned cartridge
for recycling. For more information in the U.S., call (1) (8
2445) or visit the HP LaserJet Supplies website at 
http://www.ljsupplies.com/planetpartners/. Non-US custo
call the local HP Sales and Service Office for further info
regarding the HP Planet Partners LaserJet Toner Cartrid
Program.

Paper

This printer is suited for the use of recycled papers whe
meets the guidelines outlined in the HP LaserJet Printer 
Specifications Guide. See page 25 for ordering informat
printer is suitable for the use of recycled paper accordin
DIN 19 309.
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Material Safety Data Sheet
The Toner Cartridge/Drum MSDS can be obtained by contacting the 
HP LaserJet Supplies website at:

http://ljsupplies.com/planetpartners/datasheets.html

 FIRST (Fax 
1-9300. Use 
 
ers should 
mbers and 
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If you do not have access to the Internet, call the U.S. HP
Information Retrieval Service Technology) at (1) (800) 23
Index number 7 for a listing of the Toner Cartridge/Drum
Material/Chemical Safety Data Sheets. Non-US custom
refer to the front of this manual for appropriate phone nu
information.
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Regulatory Statements 
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according to ISO/IEC Guide 22 and EN45014
Manufacturer's Name: Hewlett-Packard Company

Manufacturer's Address: 11311 Chinden Boulevard

Boise, Idaho 83714-1021, USA

declares that the product

Product Name: HP LaserJet 2100, 2100 M, 2100 TN

Model Number: C4170A, C4171A, C4172A, C4793A

Product Options: ALL

conforms to the following Product Specifications:

Safety: IEC 950:1991+A1+A2+A3 / EN 60950:1992+A1+A2+A3

IEC 825-1:1993 / EN 60825-1:1994 Class 1 (Laser/LED)

EMC: CISPR 22:1993+A1 / EN 55022:1994 Class B1

EN 50082-1:1992

IEC 801-2:1991 / prEN 55024-2:1992 - 4 kV CD, 8

IEC 801-3:1984 / prEN 55024-3:1991 - 3 V/m

IEC 801-4:1988 / prEN 55024-4:1992 - 0.5 kV Sig

1.0 kV Po

IEC 1000-3-2:1995 / EN61000-3-2:1995

IEC 1000-3-3:1994 / EN61000-3.3:1995

FCC Title 47 CFR, Part 15 Class B2) / ICES-003, Issue 2 / VCCI-2

AS / NZS 3548:1992 / CISPR 22:1993 Class B1)

Supplementary Information:

The product herewith complies with the requirements of the following Directives and ca
marking accordingly:

the EMC directive 89/336/EEC

the Low-Voltage Directive 73/23/EEC

The product was tested in a typical configuration with Hewlett-Packard Personal Comp

This Device complies with Part 15 of the FCC Rules. Operation is subject to the following
(1) this device may not cause harmful interference, and (2) this device must accept any
received, including interference that may cause undesired operation.

For Compliance Information ONLY, contact:

Australia Contact: Product Regulations Manager, Hewlett-Packar
31-41 Joseph Street, Blackburn, Victoria 3130

European Contact: Your Local Hewlett-Packard Sales and Service
Hewlett-Packard GmbH, Department HQ-TRE
Europe, Herrenberger Straße 130, D-71034 B
(FAX: +49-7031-14-3143)

USA Contact: Product Regulations Manager, Hewlett-Packa
PO Box 15 Mail Stop 160, Boise, ID 83707-00
(Phone: 208-396-6000)
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Laser Safety Statement
The Center for Devices and Radiological Health (CDRH) of the U.S. 
Food and Drug Administration has implemented regulations for laser 
products manufactured since August 1, 1976. Compliance is 
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mandatory for products marketed in the United States. T
certified as a “Class 1” laser product under the U.S. Dep
Health and Human Services (DHHS) Radiation Perform
Standard according to the Radiation Control for Health a
of 1968.

Since radiation emitted inside the printer is completely co
protective housings and external covers, the laser beam
escape during any phase of normal user operation. 

WARNING! Using controls, making adjustments, or performing proc
than those specified in this user guide may result in exp
hazardous radiation.

Canadian DOC Regulations
Complies with Canadian EMC Class B requirements. 

«Conforme à la classe B des normes canadiennes de c
électromagnétiques «CEM».»

LED Safety
The infrared port on the front panel of this printer is clas
Class 1 LED (Light Emitting Diode) device according to 
Standard IEC 825-1 (EN 60825-1). This device is not co
harmful, but the following precautions are recommended

l If the printer requires service, contact an authorized
center.

l Do not attempt to make any adjustments of the prin

l Avoid direct eye exposure to the infrared LED beam

l Be aware that the beam is invisible light and cannot

l Do not attempt to view the infrared LED beam with a
optical device.
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VCCI Statement (Japan)
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Korean EMI Statement

Laser Statement for Finland
LASERTURVALLISUUS

LUOKAN 1 LASERLAITE

KLASS 1 LASER APPARAT

HP LaserJet 2100 -laserkirjoitin on käyttäjän kannalta t
luokan 1 laserlaite. Normaalissa käytössä kirjoittimen su
estää lasersäteen pääsyn laitteen ulkopuolelle.

Laitteen turvallisuusluokka on määritetty standardin EN
(1993) mukaisesti.

VAROITUS!

Laitteen käyttäminen muulla kuin käyttöohjeessa mainit
saattaa altistaa käyttäjän turvallisuusluokan 1 ylittävälle
näkymättömälle lasersäteilylle.

VARNING!

Om apparaten används på annat sätt än i bruksanvisnin
specificerats, kan användaren utsättas för osynlig lasers
överskrider gränsen för laserklass 1.

HUOLTO

HP LaserJet  2100 -kirjoittimen sisällä ei ole käyttäjän h
olevia kohteita. Laitteen saa avata ja huoltaa ainoastaan
huoltamiseen koulutettu henkilö. Tällaiseksi huoltotoime
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katsota väriainekasetin vaihtamista, paperiradan puhdistusta tai 
muita käyttäjän käsikirjassa lueteltuja, käyttäjän tehtäväksi 
tarkoitettuja ylläpitotoimia, jotka voidaan suorittaa ilman 
erikoistyökaluja.

VARO!

mättömälle 
teeseen.

i funktion, 
ej strålen.

uksista:
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Mikäli kirjoittimen suojakotelo avataan, olet alttiina näky
lasersäteilylle laitteen ollessa toiminnassa. Älä katso sä

VARNING!

Om laserprinterns skyddshölje öppnas då apparaten är 
utsättas användaren för osynlig laserstrålning. Betrakta 

Tiedot laitteessa käytettävän laserdiodin säteilyominaisu

Aallonpituus 770-795 nm

Teho 5 mW

Luokan 3B laser
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B Media Specifications
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Overview

This printer accepts a variety of media, such as cut-she
(including up to 100% recycled fiber content paper), env
labels, transparencies, and custom-size paper. Propertie
weight, composition, grain, and moisture content are im
factors affecting printer performance and output quality. 
does not meet the guidelines outlined in this manual can
following problems:

l Poor print quality.

l Increased paper jams.

l Premature wear on the printer, requiring repair.

Note Some paper may meet all of the guidelines in this manua
produce satisfactory results. This might be the result of 
handling, unacceptable temperature and humidity levels
variables over which Hewlett-Packard has no control.

Before purchasing large quantities of paper, make sure 
meets the requirements specified in this user guide and
HP LaserJet Printer Family Paper Specification Guide. (
information, see page 25). Always test paper before buy
quantities.

CAUTION Using paper that does not meet HP specifications may ca
for the printer, requiring repair. This repair is not covered b
Packard warranty or service agreements.
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Supported Sizes of Paper

edia with a 
that has been 
mance, make 
lease refer to 

 See “Printing 

a b

ts of 80 g/m2 
 lb) paper

l

l

140  Appendix B Media Specifications

Note You may experience some paper jams when using any m
length less 178 mm (7 in.). This may be caused by paper 
effected by environmental conditions. For optimum perfor
sure you are storing and handling the paper correctly. P
“Printing and Paper Storage Environment” on page 144.

a. The printer supports a wide range of media sizes. Check the printer software for supported sizes.
on Custom-Sized Media or Cardstock” on page 39.

b. Capacity may vary depending on media weight and thickness, and environmental conditions.
c. Smoothness - 100 to 250 (Sheffield).

Tray 1 Dimensions Weight Capacity

Minimum Size 
(custom)

76 by 127 mm
(3 by 5 in.) 60 to 163 g/m2 Bond

(16 to 43 lb)
100 shee
Bond (20Maximum Size 

(custom)
216 by 356 mm
(8.5 by 14 in.) 

Transparency

Same as minimum and 
maximum paper sizes 
listed above.

Thickness:
.10 to .14 mm 
(0.0039 to 0.0055 in.)

75 typica

Labelsc Thickness:
.10 to .14 mm
(0.0039 to 0.0055 in.)

50 typica

Envelopes Up to 90 g/m2 (16-24 lb) up to 10
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a. The printer supports a wide range of media sizes. See “Printing on Custom-Sized Media or Ca
page 39.

b. Capacity may vary depending on media weight and thickness, and environmental conditions.

Tray 2 or Tray 3 Dimensions Weight Capacity

Letter 8.5 by 11 in.
(216 by 279 mm)

16 to 28 lb Bond

(60 to 105 g/m2)

250 shee

Bond (80

A4 210 by 297 mm
(8.3 by 11.7 in.)

Executive 7.3 by 10.5 in.
(191 by 267 mm)

Legal 8.5 by 14 in.
(216 by 356 mm)

B5 (ISO) 176 by 250 mm
(6.9 by 9.9 in.)

B5 (JIS) 182 by 257 mm
(7.2 by 10 in.)

A5 148 by 210 mm
(5.8 by 8.2 in.)

8.5 x 13 in. 216 by 330 mm
(8.5 by 13 in.)
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Guidelines for Using Paper

For best results, use conventional 90 g/m2 (24 lb) paper. Make sure 
the paper is of good quality, and free of cuts, nicks, tears, spots, loose 
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particles, dust, wrinkles, voids, and curled or bent edges

If you are unsure what type of paper you are loading (suc
recycled), check the label on the package of paper.

The following problems with paper cause print quality de
jamming, or even damage to the printer.

Symptom Problem with Paper Solution

Poor print quality or toner 
adhesion
Problems with feeding

Too moist, too rough, too 
smooth, or embossed; 
faulty paper lot

Try another kind o
between 100-250
4-6% moisture co

Dropouts, jamming, curl Stored improperly Store paper flat in
proof wrapping

Increased gray background 
shading/printer wear

Too heavy Use lighter paper
output bin

Excessive curl
problems with feeding

Too moist, wrong grain 
direction or short-grain 
construction

Open the rear ou
Use long-grain pa

Jamming, damage to printer Cutouts or perforations Do not use paper
or perforations

Problems with feeding Ragged edges Use good quality 
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Note Do not use letterhead paper that is printed with low-temperature inks, 
such as those used in some types of thermography.

Do not use raised or embossed letterhead.
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The printer uses heat and pressure to fuse toner to the 
sure that any colored paper or preprinted forms use inks
compatible with this fusing temperature (200° C or 392°
0.1 second).

Paper Specifications

For complete paper specifications for all HP LaserJet pri
HP LaserJet Printer Family Paper Specification Guide.

Category Specifications

Acid Content 5.5 pH to 8.0 pH

Caliper .094-.18 mm (3.0-7.0 mils)

Curl in Ream Flat within 5 mm (.02 in.)

Cut Edge Conditions Cut with sharp blades with 

Fusing Compatibility Must not scorch, melt, offse
hazardous emissions when
200° C (392° F) for .1 seco

Grain Long Grain

Moisture Content 4% to 6% by weight

Smoothness 100-250 Sheffield
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Printing and Paper Storage Environment

Ideally, the printing and paper storage environment should be at or 
near room temperature, and not too dry or too humid. Remember 
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paper is hygroscopic; it absorbs and loses moisture rapi

Heat works with humidity to damage paper. Heat causes
in paper to evaporate, while cold causes it to condense o
Heating systems and air conditioners remove most of th
from a room. As paper is opened and used, it loses mois
streaks and smudging. Humid weather or water coolers
the humidity to increase in a room. As paper is opened 
absorbs any excess moisture, causing light print and dro
as paper loses and gains moisture it can distort. This ca
paper jams.

As a result, paper storage and handling are as importan
paper-making process itself. Paper storage environmen
directly affect the feed operation.

Care should be taken not to purchase more paper than 
used in a short time (about 3 months). Paper stored for 
may experience heat and moisture extremes, which can
damage. Planning is important to prevent damage to a la
paper.

Unopened paper in sealed reams can remain stable for 
months before use. Opened packages of paper have mo
for environmental damage, especially if they are not wra
moisture-proof barrier.

The paper storage environment should be properly main
ensure optimum printer performance. The required cond
24° C (68° to 75° F), with a relative humidity of 45% to 5
following guidelines should be helpful when evaluating t
storage environment:

l Paper should be stored at or near room temperature

l The air should not be too dry or too humid (due to th
hygroscopic properties of paper).

l The best way to store an opened ream of paper is to
tightly in its moisture-proof wrapping. If the printer e
subject to extremes, unwrap only the amount of pap
during the day's operation to prevent unwanted moi
changes.
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Envelopes

Envelope construction is critical. Envelope fold lines can vary 
considerably, not only between manufacturers, but also within a box 
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from the same manufacturer. Successful printing on env
depends upon the quality of the envelopes. When selec
envelopes, consider the following components:

l Weight:  The weight of the envelope paper should n

105 g/m2 (24 lb) or jamming may occur. 

l Construction:  Prior to printing, envelopes should lie
than 6 mm (0.25 in.) curl, and should not contain air

l Condition: Envelopes should not be wrinkled, nicke
otherwise damaged. 

l Temperature:  You should use envelopes that are co
the heat and pressure of the printer.

l Size: You should use only envelopes within the follo
ranges.

Note Use only Tray 1 to print envelopes.

You may experience some paper jams when using any m
length less 178 mm (7 in.). This may be caused by paper 
effected by environmental conditions. For optimum perfor
sure you are storing and handling the paper correctly. P
“Printing and Paper Storage Environment” on page 144.

Minimum Maximum

Tray 1 76 by 127 mm
(3 by 5 in.)

216 by 35
(8.5 by 14
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Envelopes with Double Side Seams
Double side-seam construction has vertical seams at both ends of the 
envelope rather than diagonal seams. This style may be more likely to 
wrinkle. Be sure the seam extends all the way to the corner of the 

an one flap 
ith the heat 
ight cause 
 the fuser.
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envelope as illustrated below.

Envelopes with Adhesive Strips or Flaps
Envelopes with a peel-off adhesive strip or with more th
that folds over to seal must use adhesives compatible w
and pressure in the printer. The extra flaps and strips m
wrinkling, creasing, or even jams and may even damage

Correct

Incorrect
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Envelope Margins
The following gives typical address margins for a commercial #10 or 
DL envelope.
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EN Appendix B Media Spec

Note For the best print quality, position margins no closer tha
(0.6 in.) from the edges of the envelope.

Avoid printing over the area where the envelope’s seam

Envelope Storage
Proper storage of envelopes helps contribute to print qu
Envelopes should be stored flat. If air is trapped in an en
creating an air bubble, then the envelope may wrinkle du

See “Printing on Envelopes” on page 35.

Type of Address Top Margin Left Mar

Return address 15 mm (0.6 in.) 15 mm

Delivery address 51 mm (2 in.) 89 mm



EN

Labels

CAUTION To avoid damaging the printer, use only labels recommended for laser 
ion, see page 

s and always 

 or print on a 

ponent:

 at 200° C 

king between 
en the labels, 

re than 

, or other 
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printers, such as HP-brand labels. (For ordering informat
25.)

To prevent serious jams, always use Tray 1 to print label
use the rear output bin.

Never print on the same sheet of labels more than once
partial sheet of labels.

Label Construction
When selecting labels, consider the quality of each com

l Adhesives:  The adhesive material should be stable
(392° F), the printer’s fusing temperature.

l Arrangement:  Only use labels with no exposed bac
them. Labels can peel off sheets with spaces betwe
causing serious jams.

l Curl:  Prior to printing, labels must lie flat with no mo
13 mm (.5 in.) of curl in any direction. 

l Condition:  Do not use labels with wrinkles, bubbles
indications of separation. 

See “Printing on Labels” on page 37.
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Transparencies

Transparencies used in the printer must be able to withstand 200° C 
(392° F), the printer’s fusing temperature.

commended 
es. (For 
EN Appendix B Media Spec

CAUTION To avoid damaging the printer, use only transparencies re
for use in laser printers, such as HP-brand transparenci
ordering information, see page 25.)

See “Printing on Transparencies” on page 38.
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C Printer Memory and 
Expansion
EN Appendix C Printer Memory and Ex

Overview

l Printer Memory

l Installing Memory

l Checking Memory Installation

l Installing an HP JetDirect EIO Card
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Printer Memory

The printer has three dual in-line memory module (DIMM) slots for 
upgrading with:

nd 16 MB, for 

.

tions.

.

 HP LaserJet 

often print 
oaded fonts. 
print a 
le the printer 
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l More printer memory. DIMMs are available in 4, 8, a
a maximum of 52 MB. 

l DIMM-based accessory fonts, macros, and patterns

l Other DIMM-based printer languages and printer op

See “Accessories and Ordering Information” on page 23

Note Single in-line memory modules (SIMMs) used on previous
printers are not compatible with the printer.

You may want to add more memory to the printer if you 
complex graphics or PS documents, or use many downl
To find out how much memory is installed in the printer, 
configuration page by pressing GO and JOB CANCEL whi
is in the Ready state.
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Installing Memory  

CAUTION
e dual in-line 
. When 
ar an 
uently touch 

antistatic 
etal on the 

e so, print a 
ut how much 

printer before 

 page is 
r off and 
cord. 

le door by 
e tabs. 
e cables.

on and slide 
ward until the 
up.

m the printer, 
 DIMM slots.
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Static electricity can damag
memory modules (DIMMs)
handling DIMMs, either we
antistatic wrist strap or freq
the surface of the DIMMs’ 
package, then touch bare m
printer.

If you have not already don
configuration page to find o
memory is installed in the 
adding more memory.

1 After the configuration
printed, turn the printe
disconnect the power 

2 Open the interface cab
pressing on the releas
Disconnect all interfac

3 Open the top cover.

4 Press the release butt
the right side panel for
alignment arrows line 

5 Pull the panel away fro
exposing the available

Continued on next page

1

2

3

4

5
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6 Remove the DIMM from the 

he edges, 
e DIMM with 
 that the 
he DIMM slot 

Slots in 1-2-3 

ht into the 
e sure the 
he DIMM 
. (To remove 
t be 

 8 for each 

nel, line up 
nd slide the 
the release 
ce. Close the 

cable(s) and 
rinter on.

6
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antistatic package. 

7 Holding the DIMM by t
align the notches on th
the DIMM slot. (Check
locks on each side of t
are open.)

Note
For best results use DIMM 
order.

8 Press the DIMM straig
slot (press firmly). Mak
locks on each side of t
snap inward into place
a DIMM, the locks mus
released.) 

Repeat steps 6, 7, and
DIMM being installed.

9 To replace the side pa
the alignment arrows a
panel backwards until 
button latches into pla
top cover.

10 Reinstall the interface 
power cord. Turn the p

7

8

9

10
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Checking Memory Installation

To verify that DIMMs are installed correctly:

nel displays 
e startup 
y have been 

ssages” on 

ob Cancel 

e and 
e the DIMM 

 installation 

e Installed 
ge. This area 
EN Appendix C Printer Memory and Ex

1. Turn the printer on. Check that the printer control pa
the Ready light after the printer has gone through th
sequence. If an error message appears, a DIMM ma
incorrectly installed. See “Troubleshooting Error Me
page 99.

2. Print a configuration page by pressing the Go and J
buttons simultaneously.

3. Check the memory section on the configuration pag
compare it with the configuration page printed befor
installation. 

If the amount of recognized memory has not increased:

l The DIMM may not be installed correctly (repeat the
procedure). 

l Try another DIMM Slot.

l The DIMM may be defective (try a new DIMM).

Note If you installed a printer language (personality), check th
Personalities and Options section on the configuration pa
should list the new printer language.
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Installing an HP JetDirect EIO Card

1 Turn the printer off, and disconnect 

le door by 
e tabs. 
e cables.

irmly insert 
ard into the 

etaining 

 network 

cable(s) 
he interface 
inter on.

age to check 
ard appears 

1
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the power cord. 

2 Open the interface cab
pressing on the releas
Disconnect all interfac

3 Locate the EIO Slot. F
the HP JetDirect EIO c
EIO slot. Twist in the r
screws.

4 Attach the appropriate
cable to the EIO card.

5 Reinstall the interface 
power cord. Reinstall t
cable door. Turn the pr

Note
Print a PCL configuration p
that the HP JetDirect EIO c
as an installed option.

4

2

3

5

4
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D Printer 
Commands

rinter 
ation to find 

form or which 
r users who 

e with 

 printer’s 

the HP-GL/2 
quires that 
e, which can 
are 
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Overview

Most software applications do not require you to enter p
commands. See your computer and software document
the method for entering printer commands, if needed. 

PCL

PCL printer commands tell the printer which tasks to per
fonts to use. This appendix provides a quick reference fo
are already familiar with PCL command structure.

The PCL 5e printer commands are backward-compatibl
previous versions of PCL.

The PCL 6 printer commands take full advantage of the
features.

HP-GL/2

The printer has the ability to print vector graphics using 
graphics language. Printing in the HP-GL/2 language re
the printer leave PCL language and enter HP-GL/2 mod
be done by sending the proper PCL codes. Some softw
applications switch languages through their drivers.
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PJL

HP's Printer Job Language (PJL) provides control above PCL and 
other printer languages. The four major functions provided by PJL 
are: 

ettings

 used PCL 5e 
 to use PCL, 

cal Reference 
ntation” on 

 fax, call 
) and request 
pages at the 

yntax
ers: 
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l printer language switching

l job separation

l printer configuration

l status readback from the printer

PJL commands may be used to change printer default s

Note The table at the end of this appendix contains commonly
commands. For a complete listing and explanation of how
HP-GL/2, and PJL commands, order the PCL/PJL Techni
Documentation Package. See “Supplementary Docume
page 25.

To receive more information about printer commands via
HP FIRST (Fax Information Retrieval Service Technology
an index for HP LaserJet printers. (See the HP Support 
front of this user guide.)

Understanding PCL Printer Command S
Before using printer commands, compare these charact

Lowercase l: l Uppercase O: O

Number one: 1 Number 0: 0
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Many printer commands use the lowercase letter l (l) and the number 
one (1), or the uppercase letter O (O) and the number zero (0). These 
characters may not appear on your screen as shown here. You must 
use the exact character and case specified for PCL printer 
commands.

al printer 
tion).

 
rs)

r 
quence)
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The following illustration displays the elements of a typic
command (in this instance, a command for page orienta

Escape character 
(begins escape sequence)

Value field (contains both
alpha and numeric characte

Category of command
Uppercase lette

(terminates escape se
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Combining Escape Sequences
Escape sequences may be combined into one escape sequence 
string. There are three important rules to follow when combining 
code:

after the ? 

percase 
quence to 

ce must be 

the printer to 
r inch:

 commands 

ter (?). 

n be entered 

t Appears

>
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1. For each escape sequence, the first two characters 
character must be the same.

2. When combining escape sequences, change the up
(termination) character in each individual escape se
lowercase.

3. The final character of the combined escape sequen
uppercase.

The following escape sequence string would be sent to 
select legal paper, landscape orientation, and 8 lines pe

?&l3A?&l1O?&l8D

The following escape sequence sends the same printer
by combining them into a shorter sequence:

?&l3a1o8D

Entering Escape Characters
Printer commands always begin with the escape charac

The following table shows how the escape character ca
from various DOS software applications. 

DOS Software 
Application Entry Wha

Lotus 1-2-3 Type \027 027

WordPerfect for DOS Type <27> <27

MS-DOS Edit Hold down Ctrl-P, and press Esc ¨

MS-DOS Edlin Hold down Ctrl-V, release, then press [ ^[
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Selecting PCL Fonts
PCL printer commands for selecting fonts can be found on the PCL 
Font List. A sample section is shown below. Notice the two variable 
boxes for symbol set and point size:

efaults. For 
w characters, 
er common 

inter contains 
and 
n, and others). 

ch as 
lumns to line 

ed in text and 
EN Appendix D Printer Co

These variables must be filled in or the printer will use d
example, if you want a symbol set that contains line-dra
select the 10U (PC-8) or 12U (PC-850) symbol set. Oth
symbol set codes are listed in the table on page 161.

Note Fonts are either “fixed” or “proportional” in spacing. The pr
both fixed fonts (Courier, Letter Gothic, and Lineprinter) 
proportional fonts (CG Times, Arial, Times New Roma

Fixed-spaced fonts are generally used in applications su
spreadsheets and databases, where it is important for co
up vertically. Proportional-spaced fonts are generally us
word processing applications.

 

Common PCL Printer Commands

Function Command Options (#)

Job Control Commands

Reset ?E n/a

Number of Copies ?&l #X 1 to 999
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int horizontally)

Common PCL Printer Commands (continued)

Function Command Options (#)
162  Appendix D Printer Commands

Page Control Commands

Paper Source ?&l #H 0 = prints or ejects current page
1 = Tray 2
2 = manual feed, paper
3 = manual feed, envelope
4 = Tray 1
5 = Tray 3
7 = auto select

Paper Size ?&l #A 1 = Executive
2 = Letter
3 = Legal
4 = A5
5 = A4
6 = B5-JIS
8 = 8.5 X 13
9 = B5 (ISO)
71 = Postcard (single size)
72 = Postcard (round trip)
80 = Monarch
81 = Commercial 10
90 = DL
91 = International C5
100 = B5
101 = Custom

Orientation ?&l #O 0 = Portrait
1 = Landscape
2 = Reverse Portrait
3 = Reverse Landscape

Top Margin ?&l #E # = number of lines

Text Length (bottom margin) ?&l #F # = number of lines from top margin

Left Margin ?&a #L # = column number

Right Margin ?&a #M # = column number from left margin

Horizontal Motion Index ?&k#H 1/120-inch increments (compresses pr
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t vertically)

6, 24, 48)

 1 inch)

 1 inch)

Common PCL Printer Commands (continued)

Function Command Options (#)
EN Appendix D Printer Co

Vertical Motion Index ?&l #C 1/48-inch increments (compresses prin

Line Spacing ?&l #D # = lines per inch (1, 2, 3, 4, 5, 6, 12, 1

Perforation Skip ?&l #L 0 = disable
1 = enable

Cursor Positioning

Vertical Position (Rows) ?&a#R # = row number

Vertical Position (Dots) ?*p#Y # = dot number (300 dots = 1 inch)

Vertical Position (Decipoints) ?&a#V # = decipoint number (720 decipoints =

Horizontal Position 
(Columns)

?&a#C # = column number

Horizontal Position (Dots) ?*p#X # = dot number (300 dots = 1 inch)

Horizontal Position 
(Decipoints)

?&a#H # = decipoint number (720 decipoints =

Programming Hints

End of Line Wrap ?&s#C 0 = Enable
1 = Disable

Display Functions On ?Y n/a

Display Functions Off ?Z n/a
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37) Default 

) (code page 

sed in Eastern 

sed in Turkey)

Common PCL Printer Commands (continued)

Function Command Options (#)
164  Appendix D Printer Commands

Language Selection

Enter PCL Mode ?%#A 0 = Use previous PCL cursor position
1 = Use current HP-GL/2 pen position

Enter HP-GL/2 Mode ?%#B 0 = Use previous HP-GL/2 pen position
1 = Use current PCL cursor position

Font Selection

Symbol Sets ?(# 8U = HP Roman-8 Symbol Set
10U = IBM Layout (PC-8) (code page 4
Symbol Set
12U = IBM Layout for Europe (PC-850
850)
8M = Math-8
19U = Windows 3.1 Latin 1
9E = Windows 3.1 Latin 2 (commonly u
Europe)
5T = Windows 3.1 Latin 5 (commonly u
579L = Wingdings Font

Primary Spacing ?(s#P 0 = fixed
1 = proportional

Primary Pitch ?(s#H # = characters/inch

Set Pitch Modea ?&k#S 0 = 10
4 = 12 (elite)
2 = 16.5 - 16.7 (compressed)

Primary Height ?(s#V # = points

Primary Style ?(s#S 0 = upright (solid)
1 = italic
4 = condensed
5 = condensed italic
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nd for each 

Common PCL Printer Commands (continued)

Function Command Options (#)
EN Appendix D Printer Co

a. The preferred method is to use the primary pitch command.

Primary Stroke Wt. ?(s#B 0 = medium (book or text)
1 = semi bold
3 = bold
4 = extra bold

Typefacea ?(s#T Print a PCL font list to view the comma
internal font.
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accessing the printer driver 
44

accessories 23
ordering 23–25

acoustic emissions 130
additional drivers, 

obtaining 4

B
background shading on 

page 94
basics, printer 1–22
buttons 15
buying paper 28

C
canceling a print job 43
cardstock 39
characters improperly 

formed 95
checking memory 

installation 155
choosing driver 6
cleaners

using on printer 73
cleaning

engine 73
exterior 73
starting the cleaning 

process 74
toner cartridge 73

cleaning process 84
clearing paper jams 85
commands, printer 157–

165
escape sequences 160
selecting PCL fonts 161
syntax 158–160

compact disc 4
configuration page 84
control panel 15

buttons 15

deleting fonts 7
demo page 84
diagnostics, printer 7
DIMM

checking installed 
memory 155

ordering 23
upgrading 152

documentation, 
supplementary
ordering 25

DOS Remote Control 
Panel
accessing 12

drivers
OEM setup, See 

Readme on installation 
disk.

setup 7
drivers, printer

help software 6
selecting 6
switching languages 6

dropouts 93
duplex printing 40

E
energy savings 3
engine cleaning 73
envelopes

orientation 35
printing on 35
specifications 145

error messages 99
escape sequences 160

F
font list 84
fonts

deleting 7
installing 7

fonts, selecting PCL 161

G
Go button
graphics, 

H
help

online 6
printer d
software

Help butto
driver 6

help scree
HP FontS

installing
managin

HP JetAdm
HP JetSen

installing
HP LaserJ

for Maci
HP Printe

158
HP worldw
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HP-UX 7

I
image def
image def
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printing on 39
infrared port

printing with 21
installing

fonts 7
FontSmart 7

checking installation 155
expanding 153–155
installing 153–155
ordering 23
upgrading printer’s 152

memory features 3

commands 157–165
selecting fonts 161
syntax 158–160

PCL 5e drivers
function 6

PCL 6 drivers
 6
age features 2
ands 158

39

sh 11
g alternate 113
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on page 95
ty features 2
ty problems 91
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–22
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ry 155
 73
ds 157–165
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g 113
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or commands 
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JetSend 9
installing printer memory 

153–155
internal cleaning procedure 

75

J
JetAdmin

networks compatible with 
7

JetSend
installing 9

Job Cancel button 15

L
label

orientation 37
labels

specifications 148
language switching 3
languages

switching 6
Laser Writer driver 11
LaserJet Utility 11
latest drivers, obtaining 4
legal paper

loading in Tray 2 33
letterhead

printing on 42
light locations 15
locking control panel 11

M
Macintosh

printer drivers 11
printing errors 111
selecting alternate PPD 

113
software for 11
troubleshooting 110

maintenance
printer 69

media accessories
ordering 24

media input options 29
media sizes

Tray 1 29
Tray 2 30

memory

MS Windows 3.1, 95, or NT
help 6
network software 7
software 7

N
network administrator 

software 7
network issues

troubleshooting 107
Novell Netware 7
N-up printing 50

O
online help 6
overhead transparencies

specifications 149

P
paper 139

3-hole punch orientation 
42

3x5 cards 39
custom sized 39
guidelines 142
postcards 39
purchasing 28
size specifications 140

paper handling 
accessories
ordering 24

paper handling features 2
paper jam

areas 85
causes 85
output areas 89
toner cartridge area 86
Tray 2 paper feed area 

88
paper selection

default 29
paper sizes

loading in Tray 2 33
maximum 29
minimum 29

paper width guide
Tray 1 31

part numbers 23
PCL

function
PCL langu
PJL comm
postcards

printing 
PPDs

Macinto
selectin

print defec
vertical 

print quali
print quali
print spee
printer

accesso
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checkin

memo
cleaning
comman
diagnos
drivers 6
drivers, 
help sof
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155
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service 
software
syntax f

158–1
upgradin

printer driv
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help sof
software
windows

printer fea
Printer Pa

Files, se
printer set

changin
RCP 1

printing
cancelin
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double sided 40
duplexing 40
envelopes 35
forms 42
labels 37
letterhead 42

driver only 7
software

drivers 7
help for drivers 6
HP FontSmart, installing 

7

toner smearing on page 94
transfer roller 73
transparencies

printing on 38
specifications 149

Tray 1
 31
31
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pes 29
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zes 140
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zes 140
oting
anel lights 99
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ms 80
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ms 110
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multiple pages on one 
sheet 50

postcards 39
preparing for 28
quality guidelines 142
stopping print job 43
transparencies 38
with low toner 71

printing languages 6
printing problems

troubleshooting 80
problem solving checklist 

78
Product Stewardship 132–

134
memory expansion 153–

155
paper

recycled paper 139
specifications 143

product return 117
warranty

standard 121–122
PS drivers

function 6
purchasing paper 28

Q
quality, printer

toner cartridge 71
quality, printing

guidelines for 142

R
redistributing toner 71
Remote Control Panel

accessing 12
renaming the printer 113
repacking the printer 118

S
sales and service offices 

124
selecting

alternate PPD 113
self-test page, see 

configuration page
service agreements 120
Setup

HP JetSend, installing 9
HP LaserJet Utility for 

Macintosh 11
included with printer 4
Macintosh 11
Macintosh printer drivers 

11
Windows 6, 7

Solaris 7
special pages

cleaning process 84
configuration page 84
demo page 84
font list 84

specifications
envelopes 145
labels 148
paper size 140
transparencies 149

Status Messages
Attention 18
Continuable Error 19
Data 17
Fatal Error 19
Manual Feed with Pause 

17
Paper out 18
Paper out (requested 

tray) 18
processing 17
Ready 16
Startup 16

stopping a print job 43
Sun OS 7
supplementary 

documentation
ordering 25

supplies
ordering 23–25

support 117
switching printer languages 

6

T
toner cartridge 70

cleaning 73
ordering 23
recycling 70
warranty 123

toner cleaning 73

capacity
loading 
media s
media ty
opening
paper si

Tray 2
changin
media s
paper si

tray, optio
paper si

troublesho
control p
error me
general 

proble
Macinto

proble
PS prob

troublesho
78

TrueType

U
UNIX, see

V
vector gra
vertical lin

W
warranty

toner ca
wavy char
Windows

help 6
network
software

wireless p
backgro

20
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